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Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko
Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither
is any liability assumed for damages resulting from the use of the information herein. The information contained
herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson Approved
Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson
Corporation.

EPSON® isa registered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark
of Seiko Epson Corporation.

PRINT Image MatchingTM and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

Intel® is a registered trademark of Intel Corporation.
Epson Scan software is based in part on the work of the Independent JPEG Group.
libtiff

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-1S” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
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IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.

Apple, Macintosh, Mac OS, OS X, Bonjour, iPad, iPhone, iPod touch, and iTunes are trademarks of Apple Inc.,
registered in the U.S. and other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

Google Cloud Print ", Chrome' ", Chrome OS" ", and Android " are trademarks of Google Inc.

Adobe, Adobe Reader, Acrobat, and Photoshop are trademarks of Adobe systems Incorporated, which may be
registered in certain jurisdictions.

SDXC Logo is a trademark of SD-3C, LLC.
Y 4

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their
respective owners. Epson disclaims any and all rights in those marks.

Copyright © 2014 Seiko Epson Corporation. All rights reserved.

The contents of this manual and the specifications of this product are subject to change without notice.



User’s Guide

Contents
Contents
Copyright and Trademarks Basiccopying. .. ....... ... ... o L 26
Copyright and Trademarks. . .. ............... 2 Copy Mode Menu List. . ... 26
Printing
Introduction Basic.O;.)eration from the Control Panel. . . ... ... 27
Printing photos from a memory card. . . ... ... 27
Where to Find Information. . ................. 7 Print photos mode menu list. . . . .. ......... 27
Caution, Importantand Note. . . .. ............ 7 Printing using the Personal Stationery menus
Operating System Versions. . . ................ 728 27
Using Epson Connect Service. . .. .. ........... 8 Personal Stationery mode menu list. . ... ... .. 28
Basic Operation from Your Computer. . . .. ... .. 28
Printer driver and status monitor. . . .. ....... 28
. BasicPrinting. . . ....... ... ... 30
Important Instructions Canceling Printing. . ... ................. 33
Safety Instructions. . .. ......... ... . ... ..., 9 Other Options. . . . oot e e e 35
Product Advisories and Warnings. . . ........... 9 Printing photos the easy way. . . . ........... 35
Setting up/using the product. . . ............. 9 Product presets (for Windows only). . ... ... .. 36
Using the product with a wireless connection 2-sided printing (for Windows only). . . . ... .. 36
.................................... 11 Fitto pageprinting. . . ...................38
Using memorycards. . . .................. 11 Pages per sheet printing. . .. ............... 39
Using the LCD screen. . .................. 11 Sharing the Product for Printing. . . . ... ....... 40
Handlingink. . ...... ... ... . ... ... ... 12 Setup for Windows. . . . . oo o oeeereii 40
Restrictionson Copying. . .. ................ 12 Setup for MacOSX. ............coouun... 42
Basic Operation from Your Smart Device. . . . . ... 43
Getting to Know Your Product Using Epson iPrint. . .. .................. 43
Available Features. . .. .......... ... ... ... 13 Using AirPrint. . ... 44
ProductParts. . .......... ... ... . ... ...... 13
Guide to the Control Panel. . . .. ............. 15 scanning
Network statusicon:. . ................... 16 Let’'s TryScanning. . ............ ... ... .... 45
StartingaScan. . ............. ... ... ... 45
Paper and Media Handling Image Adjustment Features. . . ... .......... 47
Introduction to Using, Loading, and Storing Basic Scanning from the Control Panel. . . ... ... 49
Media. . . ov e 17 Scan mode menu list. .. ... 50
StOFING PAPEr. . . o v e e e e 17 Basic Scanning from Your Computer. . ... ...... 50
Selecting Paper. . .. ........viiiiii.. 17 Scanning in Full Auto Mode. . ............. 50
Paper type settings on the LCD screen. . . . . . . . 18 Scanning in Home Mode. . .. .............. 52
Paper type settings from the printer driver. . . . . 19 Scanning in Office Mode. ... .............. >4
Loading Paper and Envelopes. . . . ............ 19 Scan‘ning in Profess‘ion‘al Mode. ............ >6
) Previewing and Adjusting the Scan Area. . . . . . 58
Insertinga Memory Card. . ................. 23 _ .
) o Various Types of Scanning. . . ............... 60
Placing Originals. . ... .......... ... ... ..... 24 . .
Scanning a Magazine. . . .................. 60
Scanning Multiple Documents to a PDF File
Copying 62
Copying DocUments. . . .. . ...ovooeeenenn... 26 ScanningaPhoto. . .. ... ... . ... L. 64

Software Information. . ... ................. 65



User’s Guide

Starting Epson Scan Driver. . . ............
Starting Other Scanning Software. . . ... .. ..

Basic Scanning from Smart Devices. . . ... ... ..

Using EpsoniPrint. . ...................

Menu List of Control Panel

Personal Stationery Mode. . .. ..............
SetupMode. . ... i
Wi-FiSetupMode. . ......... ... ... ... ....

Refilling Ink

Ink Bottle Safety Instructions, Precautions, and

Specifications. . . .. ... ... . . L o

Safety instructions. . . . ....... ... .. .. ...
Precautions on refillingink. . . ... .........
Ink bottle specifications. . .. ..............
Checking the Ink Levels. . . .................
Refilling the Ink Tanks. . .. ................

Maintaining Your Product and
Software

Checking the Print Head Nozzles. . . ... .......

Using the Nozzle Check utility for Windows

Using the control panel. . . ...............
Cleaning the Print Head. . .. ...............

Using the Head Cleaning utility for Windows

Using the control panel. . ... .............
Aligning the PrintHead. . . . ...............

Using the Print Head Alignment utility for

Windows. . . ..o

Using the Print Head Alignment utility for

MacOSX. ...
Using the control panel. . . ...............

Replacing Ink inside the Ink Tubes. . . . .. ... ..

Using the Power Ink Flushing utility for

Windows. . . ..o

Using the Power Ink Flushing utility for Mac

Contents
65 SavingPower. . ........ ... . o L 84
66 For Windows. . ....... ... ... ... ... .... 84
67 ForMacOSX........ ... ... ... ... ... 84
67 Using the control panel. . .. ............... 84
Quieter Printer Operations. . . . .............. 85
For Windows. .. ....................... 85
ForMacOSX......... ... .. ... ... ..., 85
69 Checking the Number of Sheets of Paper Fed. . . . . 85
o Managing the Printer Status or Settings on a Web
69 Browser. . ...... ... ..o 86
70 Epson Connect Service. . . ................ 86
70 WebConfig. . ....... ... ... ... ... ... 86
71 Cleaning the Product. . .. .................. 87
Cleaning the exterior of the product. . . . ... ... 87
Cleaning the interior of the product. . . .. ... .. 87
Transporting the Product. . .. ............... 88
72 Checking and Installing Your Software. . . . ... .. 90
72 Checking the software installed on your
72 computer. . . ....... .. 90
73 Installing the software. . .................. 91
73 Uninstalling Your Software. . .. .............. 91
73 ForWindows. . . ....................... 92
ForMacOSX......... ... ... ... .. ..., 93
Transferring Data Using an External
. | Storage Device
Precautions on Storage Devices. . . ............ 94
78 Copying Files Between a Storage Device and Your
Computer. . .......... .. 94
78 Copying files to your computer. . . .. ........ 94
79 Saving files to a storage device. . . .. ......... 95
79
Error Indicators
%0 Error Messages on the Control Panel. . . ... ... .. 96
80
80 | Troubleshooting for Printing/Copying
81 Diagnosing the Problem. . . . ................ 98
Checking product status. . . ............... 99
81 PaperJams............... ... ... ... . ..., 100
81 Removing jammed paper from inside the
82 product. . ... ... 101
82 Preventing paperjams. ... ............... 102
Reprinting after a paper jam (for Windows
only). . ... 102
83 Print QualityHelp. . .. ....... .. ... ... ... 103
83 Horizontal banding. ... ................. 104




User’s Guide

Vertical banding or misalignment. . . .. ... ..
Incorrect or missing colors. . . ............
Blurry or smeared print. . . ...............

Miscellaneous Printout Problems. . ... ........

Incorrect or garbled characters. . . .. ........
Incorrect margins. . . ...... ... ...
Printout has a slightslant. . . ..............
Size or position of copied image is incorrect. . .
Inverted image. . . ........... . ... . .....
Blank pagesprint. . .. ..................
Printed side is smeared or scuffed. . . . ... ...
Printingistooslow.....................
Paper Does Not Feed Correctly. . . ...........
Paperdoesnotfeed. . ...................
Multiple pagesfeed. .. ..................
Paper is improperly loaded. . . . . ..........
Paper is not ejected fully or is wrinkled. . . . . ..

The Product Does Not Print. . . .............

A message prompting you to reset the ink
levelsis displayed. . ....................

Troubleshooting for Scanning

Problems Indicated by Messages on the LCD
Screen or Status Light. . . ..................

Problems When Startinga Scan. .. ...........

Using thebutton. . .....................
Using scanning software other than Epson
Scandriver. . ....... ... ..o oL

Problems When Feeding Paper. . . .. .........

The papergetsdirty. . ...................
Multiple sheets of paperarefed. . ... .......

Problems With Scanning Time. . . ...........
Problems With Scanned Images. . . ...........

Scan quality is unsatisfactory. . . ...........
The scanning area or direction is
unsatisfactory. . . ....... ... L oL

Problems Remain After Trying All Solutions. . . .

Product Information

InkBottles. . . ....... ...
System Requirements. . . ..................

ForWindows. . . .......... ... .. ... ....
ForMacOSX. .. ... ... . . ..

Technical Specifications. . .. ................

Printer specifications. . .. ................
Scanner specifications. . .. ...............

Contents

104 Network interface specification. . . ... ...... 121

105 Security Protocol. . ......... ... .. ... 121

105 Supported Third Party Services. . . . ........ 121

106 Memorycard. . ........ . ... ... 121

106 Mechanical. . . ........ ... o L 122

106 Electrical. . ......... ... ... ... ... ... 122

106 Environmental. . . ........ ... ... . .... 123

107 Standards and approvals. . . .............. 123

107 Interface. . ....... ... ... L 124

107

107 | Where To Get Help

108 Technical Support Web Site. . . .............. 125

108 Contacting Epson Support. . . ............... 125

ig: Before Contacting Epson. . .. ............. 125

109 Help for Users in Europe. . . .............. 126

109 Help for Users %n T'aiwan ................. 126
Help for Users in Singapore. . . .. .......... 127

109 Help for Users in Thailand. . .. ............ 127

109 Help for Users in Vietnam. . . ............. 128

109 Help for Users in Indonesia. . . ............ 128
Help for Users in HongKong. ... .......... 129

110 Help for Users in Malaysia. . ... ........... 129
Help for UsersinIndia. . . ............... 130
Help for Users in the Philippines. . . ... ... .. 131

111

111 Index

112

113

113

113

113

113

113

113

115

116

117

117

117

117

118

118

120




User’s Guide

Introduction

Introduction

Where to Find Information

The latest version of the following manuals are available on the Epson support website.
http://www.epson.eu/Support (Europe)
http://support.epson.net/ (other than Europe)
[ Start Here (paper):
Provides you with information on setting up the product and installing the software.

1 User’s Guide (PDF):

This manual. Provides instructions on using the printer, refilling ink, maintenance, and solving problems.
To view the PDF manual, you need Adobe Acrobat Reader 5.0 or later, or Adobe Reader.

d Network Guide (PDF):

Provides network administrators with information on both the printer driver and network settings.

Caution, Important and Note

Caution, Important, and Note in this manual are indicated as below and have the following meaning.

Caution
must be followed carefully to avoid bodily injury.

g Important

must be observed to avoid damage to your equipment.

Note
contain useful tips and restrictions on product operation.

Operating System Versions

In this manual, the following abbreviations are used.
d  Windows 8.1 refers to Windows 8.1 and Windows 8.1 Pro.
[ Windows 8 refers to Windows 8 and Windows 8 Pro.

[ Windows 7 refers to Windows 7 Home Basic, Windows 7 Home Premium, Windows 7 Professional, and
Windows 7 Ultimate.


http://www.epson.eu/Support
http://support.epson.net/

User’s Guide

Introduction

1  Windows Vistarefers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, Windows
Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate Edition.

d Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and Windows XP
Professional.

d  Mac OS X refers to Mac OS X 10.6.8, 10.7.x, 10.8.x and 10.9.x.

Using Epson Connect Service

Using Epson Connect and other companies’ services, you can easily print directly from your smartphone, tablet PC or
laptop, anytime and practically anywhere even across the globe! The services available vary by product. (# “Available
Features” on page 13)

For more information about the printing and other services, visit the following URL:
https://www.epsonconnect.com/ (Epson Connect portal site)
http://www.epsonconnect.eu (Europe only)

Note:

You can make network service settings using a Web browser on your computer, smartphone, tablet PC, or laptop that is
connected to the same network as the product.

= “Managing the Printer Status or Settings on a Web Browser” on page 86
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Important Instructions

Safety Instructions

Read and follow these instructions to ensure safe use of this product. Make sure you keep this guide for future
reference. Also, be sure to follow all warnings and instructions marked on the product.

4 Useonlythe power cord supplied with the product and do not use the cord with any other equipment. Use of other
cords with this product or the use of the supplied power cord with other equipment may result in fire or electric
shock.

[ Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the product’s guides.

4 Unplug the product and refer servicing to qualified service personnel under the following conditions:

The power cord or plug is damaged; liquid has entered the product; the product has been dropped or the casing
damaged; the product does not operate normally or exhibits a distinct change in performance. Do not adjust
controls that are not covered by the operating instructions.

4 Place the product near a wall outlet where the plug can be easily unplugged.

[ Do not place or store the product outdoors, near excessive dirt or dust, water, heat sources, or in locations subject
to shocks, vibrations, high temperature or humidity.

[ Take care not to spill liquid on the product and not to handle the product with wet hands.

4 Keep this product at least 22 cm away from cardiac pacemakers. Radio waves from this product may adversely
affect the operation of cardiac pacemakers.

(4 Ifthe LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

Note:

The following provides safety instructions for ink bottles.
= “Refilling Ink” on page 72

Product Advisories and Warnings

Read and follow these instructions to avoid damaging the product or your property. Make sure you keep this guide for
future reference.

Setting up/using the product

4

Do not block or cover the vents and openings in the product.
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Important Instructions

Use only the type of power source indicated on the product’s label.
Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
Avoid electrical outlets controlled by wall switches or automatic timers.

Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over. Be
particularly careful to keep all the power-supply cords straight at the ends and the points where they enter and
leave the transformer.

If you use an extension cord with the product, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all

devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.

If you plan to use the product in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the product.

When connecting the product to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may
damage both devices connected by the cable.

Place the product on a flat, stable surface that extends beyond the base of the product in all directions. If you place
the product by the wall, leave more than 10 cm between the back of the product and the wall. The product will not

operate properly if it is tilted at an angle.

When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

Allow spaces behind the product for the cables, and space above the product so that you can fully raise the
document cover.

Leave enough space in front of the product for the paper to be fully ejected.

Avoid places subject to rapid changes in temperature and humidity. Also, keep the product away from direct
sunlight, strong light, or heat sources.

Do not insert objects through the slots in the product.
Do not put your hand inside the product during printing.
Do not touch the white flat cable and ink tubes inside the product.

Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause
fire.

Do not move the print head by hand; otherwise, you may damage the product.

Always turn the product off using the O button. Do not unplug the product or turn off the power at the outlet until
the LCD screen has turned off completely or the O light stops flashing.

Before transporting the product, make sure that the print head is in the home (far right) position.

10
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Be careful not to trap your fingers when closing the scanner unit.

Do not continue printing when the ink level is below the lower line on the ink tank. Continued use of the product
when the inklevel is below the lower line could damage the product. Epson recommends filling all ink tanks to the
upper line when the product is not operating to reset the ink levels.

If you are not going to use the product for a long period, be sure to unplug the power cord from the electrical
outlet.

Do not press too hard on the scanner glass when placing the originals.

During the life of your product it may be necessary to replace the waste ink pad when it has become full. Whether
and how often this is required will vary according to the number of pages you print, the type of material that you
print and the number of cleaning cycles that the product performs. Epson Status Monitor, your LCD, or lights on
the control panel will advise you when this part needs replacing. The need for replacement of the pad does not
mean that your product has ceased to operate in accordance with its specifications. The replacement of this part is
aroutine product servicing activity within the product’s specification and is not a problem which requires repair.
The Epson warranty does not therefore cover the cost of this replacement. If your product needs the pad replacing
this can be performed for you by any authorised Epson service provider. It is not a user-serviceable part.

Using the product with a wireless connection

4

Do not use this product inside medical facilities or near medical equipment. Radio waves from this product may
adversely affect the operation of electrical medical equipment.

Do not use this product near automatically controlled devices such as automatic doors or fire alarms. Radio waves
from this product may adversely affect these devices, and could lead to accidents due to malfunction.

Using memory cards

Note:
The availability of this feature varies by product.

4

4

Do not remove a memory card or turn off the product while the memory card light is flashing.

The methods for using memory cards vary according to card type. Be sure to refer to the documentation packaged
with your memory card for details.

Use only memory cards compatible with the product.

= “Memory card” on page 121

Using the LCD screen

4

|

The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

Only use a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

11
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[ The exterior cover of the LCD screen could break if it receives a heavy impact. Contact your dealer if the panel
surface chips or cracks, and do not touch or attempt to remove the broken pieces.

4 Do not operate by a sharp edge thing such as a ball point pen, sharp pencil, stylus pen and so on.

1 Condensation inside the panel due to abrupt changes in temperature or humidity may cause performance to
deteriorate.

Handling ink

We will provide ink-related safety instructions and product advice/warnings in the linked section (before “Refilling
Ink” section).

= “Refilling Ink” on page 72

Restrictions on Copying

Observe the following restrictions in order to ensure the responsible and legal use of the product.

Copying of the following items is prohibited by law:

[d  Bankbills, coins, government-issued marketable securities, government bond securities, and municipal securities
[ Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

d  Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

[ Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

[ Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:
d  Products can be misused by improperly copying copyrighted materials. Unless acting on the advice of a

knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

12
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Getting to Know Your Product

Available Features

Check what is available for your product.

Features

Print from a computer v
from a memory card v

Copy Standard copy v
Borderless copy

Scan from a computer v
from product to a computer v
from product to a memory card

Epson Connect services iPrint v
Email Print v
Remote Print Driver v
Scan to Cloud

Other companies’ services AirPrint v
Google Cloud Print v

Product Parts
f

13
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Getting to Know Your Product

Paper support

Output tray

Stopper

Feeder guard

Edge guide

Sheet feeder

Release lever (rear of the control panel)

a.

b.

C.

d.

e.

f.
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a. Scanner Unit

b. Print head

C. Ink tank unit

d. Ink reservoir tanks (Ink tanks)

e. Ink tubes

a. USB connector for connecting to a computer
b. ACinlet

Guide to the Control Panel

Buttons/Lights/Icons

Function

: C

Turns the product on and off. The button light stays on when the product is on. Flashes when
the product is receiving data, printing/copying/scanning, or cleaning the print head.

b " Returns to the top menu.
c - LCD screen (1.44-inch)
d <4 AP, V0K Press 4, A, D, ¥ to select menus. Press OK to confirm the setting you have selected and go to

next screen.

Starts the operation you selected.

Stops the current operation or returns to the previous screen.

15
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Network status icon:

Icons

Status

Indicates a problem with the printer’s wireless (Wi-Fi) network connection, or that the printer is
searching for a wireless (Wi-Fi) network connection.

Indicates that the printer is connected to a wireless (Wi-Fi) network.
The number of bars indicates the signal strength of the connection. The more bars there are, the
stronger the connection.

| o o

)

T
[ .

Indicates that the printer is connected to a wireless (Wi-Fi) network in Ad Hoc mode.

Indicates that a wireless (Wi-Fi) network is disabled, or that the printer is connecting.

Indicates that the printer is connected to a wireless (Wi-Fi) network in Simple AP mode.

Indicates that the printer is connected to a wireless (Wi-Fi) network in Wi-Fi Direct mode.

Tl

Indicates that Wi-Fi Direct is disabled, or that the printer is connecting.

16
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Paper and Media Handling

Paper and Media Handling

Introduction to Using, Loading, and Storing Media

You can achieve good results with most types of plain paper. However, coated papers provide superior prints because
they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet products, and recommends these
papers to ensure high-quality results.

When loading special paper distributed by Epson, read the instruction sheets packed with the paper first and keep the
following points in mind.

Note:

0 Load the paper into the rear paper feed printable side up. The printable side is usually whiter or glossier. See the
instruction sheets packed with the paper for more information. Some types of paper have cut corners to help identify the
correct loading direction.

0 Ifthe paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may
cause ink to smear on your prints. Do not use the paper that is folded, wavy or torn.

08

Storing paper

Return unused paper to the original package as soon as you finish printing. When handling special media, Epson
recommends storing your prints in a resealable plastic bag. Keep unused paper and prints away from high
temperature, humidity, and direct sunlight.

Selecting Paper

The table below lists supported papers. Loading capacity varies by paper as shown.

Media Type Size Loading capacity (sheets)

17




User’s Guide

Paper and Media Handling

Plain paper”’ Letter™2 upto 11mm
A4™2 up to 11mm
B5™2 up to 11mm
A52 up to 11Tmm
A6™2 up to 11mm
Legal 1
User Defined 1

Envelope #10 10
DL 10
cé6 10

Epson Bright White Ink Jet Paper A4*2 80

Epson Photo Quality Ink Jet Paper | A4 80

Epson Matte Paper - Heavyweight | A4 20

Epson Premium Glossy Photo Ad 20

Paper
10x15cm(4x6in) 20
13x18cm(5x7in) 20
16:9 wide size (102x181mm) 20

*1 Paper with a weight of 64 g/m? (17 Ib) to 90 g/m? (24 Ib).

*2 The loading capacity for manual 2-sided printing is 30 sheets.

Note:

The availability of special media varies by location. For the latest information on media available in your area, contact

Epson support.

® “Technical Support Web Site” on page 125

Paper type settings on the LCD screen

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper LCD paper type
Plain paper plain papers
Epson Bright White Ink Jet Paper

Epson Premium Glossy Photo Paper Prem, Glossy
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For this paper LCD paper type

Epson Matte Paper - Heavyweight Matte

Epson Photo Quality Ink Jet Paper

Paper type settings from the printer driver

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper Printer driver paper type

Plain paper* plain papers

Epson Bright White Ink Jet Paper*

Epson Premium Glossy Photo Paper* Epson Premium Glossy

Epson Matte Paper — Heavyweight* Epson Matte

Epson Photo Quality Ink Jet Paper*

Envelopes Envelope

* These paper types are compatible with Exif Print and PRINT Image Matching. For more information, refer to the documentation
that came with the Exif Print or PRINT Image Matching compatible digital camera.

Loading Paper and Envelopes

Follow these steps to load paper.

Flip the feeder guard forward.

A
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Slide out the paper support and the output tray and then raise the stopper.

Slide the edge guide to the left.

n Fan and align the edges of the paper sheets. Then load them with the printable side up, against the right side of
the sheet feeder.
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Note:
1 The printable side is often whiter or brighter than the other side.

0 Alwaysload paper into the sheet feeder short edge first, even when you are printing landscape -oriented pictures.

1 You can use paper with binding holes. Load only one sheet of paper at a time. Make sure you adjust the size of
your file to avoid printing over the binding holes.

d  When loading envelopes, load the short edge first with the flap facing down.

N

_—
/

&

A Do not use envelopes that are curled, folded, or glued or that have plastic windows.

[ Flatten the envelope and the flaps before loading.

Ef) 2o

A Flatten the leading edge of the envelope before loading.

[  Avoid using envelopes that are too thin, as they may curl during printing.
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Slide the edge guide against the left edge of the paper, but not too tightly.

~

)
—

=T

-

///I/

/

Note:
For plain paper, do not load paper above the ¥ arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.

® “Selecting Paper” on page 17

Flip the feeder guard back.

To prevent foreign materials from getting into the product, make sure you flip the feeder guard back when you
have finished printing.

Check the current paper size and paper type settings displayed on the control panel. To use the settings, select
Do Not Change and then press OK. To change the settings, select Change, press OK, and then go to the next
step.

Important:
The paper setup screen is not displayed if the paper is not loaded along the right edge of the rear paper feed. An
error occurs when you start printing.

Note:
If you have disabled the Paper Configuration setting, the paper setting screen is not displayed.
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E On the paper size setting screen, select the paper size and then press OK.

On the paper type setting screen, select the paper type and then press OK.

Note:
You can also display the paper size and paper type settings screen by selecting Setup > Printer Setup > Paper Source
Settings > Paper Setup.

Inserting a Memory Card

You can print photos in a memory card or save a scanned data in a memory card. The following memory cards are
supported.

SD, SDHC, SDXC

The following memory cards are available with an adapter.

g Important

Make sure you attach an adapter before inserting the card into the slot, otherwise the card may get stuck.

d  miniSD, microSD, miniSDHC, microSDHC, microSDXC

-
saﬂ
=

Insert one card at a time.
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Check the light stays on.

N
~ =

O =) O ~
=

[] = on, ] =flashing

u Important

[ Do not try to force the card all the way into the slot. It should not be fully inserted.

[ Do not remove the memory card while the light is flashing. The data in the memory card may be lost.

Placing Originals

Open the document cover and place your original face-down on the scanner glass.
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Slide the original to the corner.

Note:
See the following sections if any problems occur with the scanning area or the scanning direction when using EPSON
Scan.

= “The edges of your original are not scanned” on page 115
> “Multiple documents are scanned into a single file” on page 115

Close the cover gently.
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Copying

Copying Documents

Basic copying
Follow the steps below to copy documents.

Load paper.
= “Loading Paper and Envelopes” on page 19

-

Place your original(s) on the scanner glass.
= “Placing Originals” on page 24

N

Enter the Copy mode from the Home menu.

Set the number of copies using the A or ¥ button.

Select Color or B&W.

Press OK and then press V.

Select the appropriate copy settings such as layout, paper size, paper type, and copy quality. Use A or ¥ to select
a setting item and use € or P to change the setting. Press OK to save the changes.

~Hogols N

Press < to start copying.

Copy Mode Menu List

Refer to the section below for the Copy mode menu list.
= “Copy Mode” on page 69
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Printing

Basic Operation from the Control Panel

Printing photos from a memory card
Follow the steps below to print photos directly from a memory card.

Load photo paper.

-

= “Loading Paper and Envelopes” on page 19

Insert a memory card.

N

= “Inserting a Memory Card” on page 23

Enter Print Photos mode from the Home menu.

Use €or P> to select a photo and set the number of copies using the A or ¥ button. Repeat this step for all the
photos you want to print.

Press OK and then press V.

Selectthe appropriate print settings such as paper size and paper type. Use A or ¥ to selecta setting item and use

oo s Nw

<« or P to change the setting. Press OK to save the changes.

Press <& to start printing.

~

Print photos mode menu list

Refer to the section below for the Print Photos mode menu list.
= “Print Photos Mode” on page 69

Printing using the Personal Stationery menus

Personal Stationery provides you with many special menus that make printing easy and fun! Select Personal
Stationery from the Home menu, and then see the explanations below to select the menu you want.
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Menu Function

You can print lined paper, graph paper, and
music paper. Follow the on-screen
instructions to print.

Lined Papers

Writing Papers You can print your own lined paper with or
without a photo set as the background. Follow
the on-screen instructions to print.

Calendar You can print monthly or weekly calendars. For
monthly calendars, you can specify the year
and month. Follow the on-screen instructions
to print.

Personal Stationery mode menu list
Refer to the section below for the Personal Stationery mode menu list.

= “Personal Stationery Mode” on page 70

Basic Operation from Your Computer

Printer driver and status monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results. The status monitor and
the printer utilities help you check the product and keep it in top operating condition.
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Note for Windows users:

[ Your printer driver automatically finds and installs the latest version of the printer driver from Epson’s Web site. Click
the Software Update button in your printer driver’s Maintenance window, and then follow the on-screen instructions.
Ifthe button does not appear in the Maintenance window, point at All Programs or Programs in the Windows Start
menu, and check in the EPSON folder.*

* For Windows 8.1 and 8.
Ifthe button does not appear in the Maintenance window, right-click on the Start screen, or swipe from the bottom or
top edge of the Start screen and select All apps, then select Software Update from EPSON category.

1 Ifyouwant to change the language of the driver, select the language you want to use from the Language setting in your
printer driver’s Maintenance window. Depending on the location, this function may not be available.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the desktop or the taskbar.
To make settings that apply only to the application you are using, access the printer driver from that application.

To make settings that apply to all of your Windows applications, access the printer driver from the desktop or the
taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows 7.

From Windows applications

Click Print or Print Setup on the File menu.

In the window that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on your
application, you may need to click one or a combination of these buttons.)

From the desktop

[ Windows 8.1 and 8:
Select Desktop, Settings charm, and Control Panel. Then select Devices and Printers from the Hardware and
Sound category. Right-click on the product, or press and hold the product and select Printing preferences.

1 Windows 7:
Click the start button, select Devices and Printers. Then right-click the product and select Printing
preferences.

Jd Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.
Then select the product and then click Select printing preferences.

d Windows XP:

Click Start, Control Panel, (Printers and Other Hardware,) then Printers and Faxes. Select the product, then
click Printing Preferences on the File menu.

From the shortcut icon on the taskbar
Right-click the product icon on the taskbar, then select Printer Settings.
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To add a shortcut icon to the Windows taskbar, first access the printer driver from the desktop as described above.
Next, click the Maintenance tab, and then the Monitoring Preferences button. In the Monitoring Preferences
window, select the Shortcut Icon check box.

Getting information through online help

In the printer driver window, try one of the following procedures.
4 Right-click the item, then click Help.

0 Click the:a: button at the top right of the window, then click the item (for Windows XP only).

Accessing the printer driver for Mac OS X

The table below describes how to access the printer driver dialog.

Dialog Box How to Access It
Page Setup Click Page Setup on the File menu of your application.
Note:

Depending on your application, the Page Setup menu may not appear in the File menu.

Print Click Print on the File menu of your application.

Epson Printer Utility 4 For Mac OS X 10.9, 10.8 or 10.7, click System Preferences on the Apple menu and then click
Printers & Scanners (for Mac OS X 10.9) or Print & Scan (for Mac OS X 10.8 or 10.7). Select your
product from the Printers list box, click Options & Supplies, Utility, and then click Open Printer
Utility.

ForMacOS X 10.6, click System Preferences on the Apple menu and then click Print & Fax. Select
your product from the Printers list box, click Options & Supplies, Utility, and then click Open
Printer Utility.

Basic Printing

Note:
[ Before you print, load paper properly.
™ “Loading Paper and Envelopes” on page 19
4 Refer to the section below for the printable area.
™ “Printable area” on page 119

[ After completing the settings, print one test copy and examine the results before printing an entire job.

Basic product settings for Windows

Open the file you want to print.
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2 Access the printer settings.
= “Accessing the printer driver for Windows” on page 29

&

[?1 Printing Preferences @

Main L ore Options | Maintenance |

Printing Presets ‘

| Add/Remove Presets... I Document Size [M 210 % 2597 mm - |

J:: Document - Fast

r :
= Document - Standard Quality Orientation @ Portrait (7 Landscape
t_-=1 Document - High Quality
|§'£—| Document - 2-Up paper Type IP‘Ei” papers v]
=| Document - Fast Grayscale )
%2 Document - Grayscale Quality [Standard - |
Color @ Color (7 Grayscale
2-Sided Printing | Off -

Settings.

—— Multi-Page Off - Page Order..
-_I Copies 1 2 [ collate
e [T Reverse Order

Quiet Mode |off -

Show Settings i:| Print Preview

[~ 30b Arranger Lite

| Reset Defaults | I Ink Levels |

[ ok | caneel || Heb

Click the Main tab.

Select the appropriate Document Size setting. You can also define a custom paper size. For details, see the online
help.

Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Bl BB

Note:
Select Landscape when printing on envelopes.

E Select the appropriate Paper Type setting.
= “Paper type settings from the printer driver” on page 19

Note:
Print quality is automatically adjusted for the selected paper type setting.

Click OK to close the printer settings window.

Note:
To make changes to advanced settings, refer to the relevant section.

E Print your file.
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Basic product settings for Mac OS X

Note:
Screen shots of the printer driver windows in this manual are from Mac OS X 10.7.

Open the file you want to print.

2 Access the Print dialog box.
= “Accessing the printer driver for Mac OS X” on page 30

PR | @ EPSONJOLOXX.

ap

Presets: | Default Settings

Copies:

Pages: (&) All :
[ JFrom: |1 to: |1
Paper Size: | A4 @210 by 297 mm
Qrientation: Ii ‘TE ‘
| Preview =

[E Auto Rotate

(_5cale: 80 %
(®) Scale to Fit: () Print Entire Image
(_IFill Entire Paper

Copies per page: | 1 =

| Cancel | [\ Print |

Note:
If the simplified dialog box is displayed, click the Show Details button (for Mac OS X 10.9, 10.8 or 10.7) or the ¥
button (for Mac OS X 10.6) to extend this dialog box.

Select the product you are using as the Printer setting.

Note:
Depending on your application, you may not be able to select some of the items in this dialog box. If so, click Page

Setup on the File menu of your application, and then make suitable settings.

n Select the appropriate Paper Size setting.
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Select the appropriate Orientation setting.

Note:
Select landscape orientation when printing envelopes.

E Select Print Settings from the pop-up menu.

Printer: [ EPSON XX0XXX B3
Presets: | Standard |
Copies: D ™ Collated
Pages: (=) All
(JFrom: |1 to: 1
Paper Size: | A4 Fe 21.00 by 29.70 cm
Orientation: I ‘ﬂl Scale: 100 %
[ Print Settings )

Media Type: | plain papers

2 (&

Print Quality: [ Mormal

"1 Grayscale

™ Mirror Image

( Cancel )| (S5Print=)

7 Select the appropriate Media Type setting.
= “Paper type settings from the printer driver” on page 19

E Click Print to start printing.

Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.
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Using the control panel

Press @ to cancel a print job in progress.

For Windows

Note:
You cannot cancel a print job that has been completely sent to the product. In this case, cancel the print job by the product.

1 Access the EPSON Status Monitor 3.
= “For Windows” on page 99

Click the Print Queue button. The Windows Spooler appears.
Right click on the job you want to cancel and then select Cancel.

For Mac OS X

Follow the steps below to cancel a print job.

Note:
If you have sent a print job from a Mac OS X 10.6 through the network, you may not be able to cancel printing from the

computer. Press @ on the product’s control panel to cancel a print job. To solve this problem, see the online Network Guide.

Click your product icon in the Dock.
In the Document Name list, select the document which is printing.

Click the Delete button to cancel the print job.

&}

Printing ‘Document’.
‘ Sanding data
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For Mac OS X 10.9 or 10.8:
Click the ' button to cancel the print job.
800 & EPSON XXXXXX - 1 Job
Pause Settings Scanner

~ Untitled
FOF Printir L na for orint O

Other Options

Printing photos the easy way

Epson Easy Photo Print lets you lay out and print digital images on various types of paper. The step-by-step
instructions in the window let you preview the printed images and get the effects you want without having to make any

difficult settings.

Using the Quick Print function, you can perform one-click printing with the settings you make.

Starting Epson Easy Photo Print

For Windows

4

4

Double-click the Epson Easy Photo Print icon on the desktop.

For Windows 8.1 and 8:
Select All apps, and then select Easy Photo Print from Epson Software.

For Windows 7 and Vista:

Click the start button, point to All Programs, click Epson Software, and then click Easy Photo Print.

For Windows XP:

Click Start, point to All Programs, point to Epson Software, then click Easy Photo Print.

For Mac OS X

Double-click the Applications folder on your Mac OS X hard drive, then double-click in turn on the Epson Software

and Easy Photo Print folders and finally double-click the Easy Photo Print icon.
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Product presets (for Windows only)

Printer driver presets make printing a snap. You can also create presets of your own.

Product settings for Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 29

Select a Printing Presets in the Main tab. Product settings are automatically set to the values displayed in the
pop-up window.

2-sided printing (for Windows only)

Use the printer driver to print on both sides of the paper.
S| (/ =
N =
|

Two types of 2-sided printing are available: standard and folded booklet.

2-sided printing is only available for the following papers and sizes.

Paper Size
Plain paper Legal, Letter, A4, B5, A5, A6
Epson Bright White Ink Jet Paper A4
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Note:

1 This feature is not available for Mac OS X.

[ This feature may not be available at some settings.

[ This feature may not be available when the product is accessed over a network or is used as a shared printer.

1 The loading capacity differs during 2-sided printing.
= “Selecting Paper” on page 17

[ Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may deteriorate.

A Depending on the paper and the amount of ink used to print text and images, ink may bleed through to the other side of
the paper.

A The surface of the paper may be smeared during 2-sided printing.

A This feature is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor, access the printer

driver and click the Maintenance tab followed by the Extended Settings button. In the Extended Settings window,
check the Enable EPSON Status Monitor 3 check box.

Product settings for Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 29

Select 2-Sided Printing check box.

Click Settings, and make the appropriate settings.

Note:
If you want to print a folded booklet, select Booklet.

Check the other settings and print.

Note:
1 The actual binding margin may be different from the specified settings depending on your application.
Experiment with a few sheets to examine actual results before printing the entire job.

0 Make sure that the ink is completely dry before reloading the paper.
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Fit to page printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer driver.

Note:
This feature may not be available at some settings.

Product settings for Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 29

Select Reduce/Enlarge Document and Fit to Page in the More Options tab, and then select the size of the paper
you are using from Output Paper.

Check the other settings and print.

Product settings for Mac OS X

Access the Print dialog box.
= “Accessing the printer driver for Mac OS X” on page 30

Choose Scale to fit paper size for Destination Paper Size in the Paper Handling pane, and then select the size of
the paper you are using from the pop-up menu.

Check the other settings and print.
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Pages per sheet printing

Lets you use the printer driver to print two or four pages on a single sheet of paper.

Note:
This feature may not be available at some settings.

Product settings for Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 29

Select 2-Up or 4-Up as Multi-Page in the Main tab.
Click Page Order, and make the appropriate settings.

n Check the other settings and print.

Product settings for Mac OS X

1 Access the Print dialog box.
= “Accessing the printer driver for Mac OS X” on page 30

Select the desired number of Pages per Sheet and the Layout Direction (page order) in the Layout pane.

Check the other settings and print.
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Sharing the Product for Printing

Setup for Windows

These instructions tell you how to set up your product so other users on the network can share it.

First you will set up the product as a shared printer on the computer directly connected to it. Then you will add the
product to each network computer that will access it.

Note:
A These instructions are for small networks only. To share the product on a large network, consult your network
administrator.

[ The screen shots in the following section are from Windows 7.

Setting up the product as a shared printer

Note:
[ To set up the product as a shared printer in Windows 8.1, 8, 7 or Vista, you will need an account with administrator
privileges and the password if you log on as a standard user.

d  To set up the product as a shared printer in Windows XP, you must log on to a Computer Administrator account.

Follow the steps below on the computer that is connected directly to the product:

Windows 8.1 and 8:

Select Control Panel from Settings. Then select Devices and Printers from the Hardware and Sound
category.

Windows 7:
Click the start button, select Devices and Printers.

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP:
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

Windows 8.1, 8 and 7:

Right-click on the product, or press and hold the product, and select Printer properties, and then select
Sharing. Then select the Change Sharing Options button.

Windows Vista:
Right-click the icon for your product, and then click Sharing. Click the Change sharing options button and
then click Continue.

Windows XP:
Right-click the icon for your product, then click Sharing.

40



User’s Guide

Printing

Select Share this printer, then type a Share name.

Note:
Do not use spaces or hyphens in the share name.

#5) EPSON XXXXXCOEXXXX Properties (=]
Color Management | Security | Wersion Information
General Sharing | Forts | Advanced

/I you share this printer, only users on your network with a username
% and password for this computer can print to it. The printer will not
be available when the computer sleeps. To change these settings,
use the Network and Sharing Center.

[¥] Share this printer
Share name: | EPS0N

[#] Render print jobs on client computers

Drivers

If this printer is shared with users running different versicns of
Windows, you may want to install additional drivers, so that the
users do not have to find the print driver when they connect to the

shared printer.
Additional Drivers...

ok JJ{ cancel J[ oy ]

If you want to automatically download printer drivers for computers that are running different versions of
Windows, click Additional Drivers and select the environment and the operating systems of the other
computers. Click OK, then insert the product software disk.

n Click OK or Close (if you installed additional drivers).

Adding the product to the other network computers

Follow these steps to add the product to each network computer that will access it.

Note:

Your product must be set up as a shared printer on the computer to which it is connected before you can access it from
another computer.

= “Setting up the product as a shared printer” on page 40

1 Windows 8 and 8:
Select Control Panel from Settings. Then select Devices and Printers from the Hardware and Sound

category.

Windows 7:
Click the start button, select Devices and Printers.

1



User’s Guide

Printing

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP:
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

Windows 8, 7 and Vista:
Select the Add a printer button.

Windows XP:
Click the Add a printer button. The Add Printer Wizard appears. Click the Next button.

Windows 8:
Go to Step 4.

Windows 7 and Vista:
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP:
Select A network printer, or a printer attached to another computer, then click Next.

5

o) = Add Printer

What type of printer do you want to install?

< Add a local printer
Use this option only if you don't have a USB printer. (Windows automatically installs USB printers |
when you plug them in.) H

< Add a network, wireless or Bluetooth printer

Make sure that your computer is connected to the network, or that your Bluetooth or wireless
printer is turned on.

Canee!

n Follow the on-screen instructions to select the product you want to use.

Note:

Depending on the operating system and the configuration of the computer to which the product is connected, the Add Printer
Wizard may prompt you to install the printer driver from the product software disk. Click the Have Disk button and follow
the on-screen instructions.

Setup for Mac OS X

Tosetup your product on a Mac OS X network, use the Printer Sharing setting. See your Macintosh documentation for

details.
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Basic Operation from Your Smart Device

Using Epson iPrint

EpsoniPrintisan application thatallows you to print photos, documents, and Web pages from a smart device such asa
smartphone or tablet. You can use local print, printing from a smart device that is connected to the same wireless
network as your printer, or remote print, printing from a remote location over the Internet. To use remote print,
register your printer in the Epson Connect service.

- EPSON

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Using Epson iPrint

Start Epson iPrint from your smart device and select the item you want to use from the home screen. The following
screens are subject to change without notice.

Epson iPrint

Printer is not selected. ,

Tan here to select a orinter.
ho >
7] Photos

"“I5}| saved Documents

0 rlii‘ | Online Storage

[,* Web Page Print

Q Scan
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(1) Home screen displayed when the application is started.

(2] Displays information on how to setup the printer and a FAQ.

(3] Displays the screen whereyou can select the printer and make printer settings. Once you have selected the printer,youdo
not need to select it again from the next time.

(4] Select what you want to print such as photos, documents, and web pages.

(5] Displays the screen to make print settings such as paper size and paper type.

(6) Displays the paper size. When this is displayed as a button, press it to display the paper settings currently set on the
printer.

(7] Displays photos and documents you selected.

© | Starts printing.

Note:

To print from the document menu using iPhone, iPad, and iPod touch running iOS, start Epson iPrint after transferring the
document you want to print using the file sharing function in iTunes.

Using AirPrint

AirPrint allows you to wirelessly print to your AirPrint-enabled printer from your iOS device using the latest version
of iOS and from your Mac using OS X v10.7.x or later.

AirPrint

Note:
See the AirPrint page of the Apple website for more details.

Load paper in the printer.

Connect your device to the same wireless network that your printer is using.

Print from your device to your printer.
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Scanning

Let’s Try Scanning

Starting a Scan
Let’s scan a document to get used to the process.

Place your original(s) on the scanner glass.
= “Placing Originals” on page 24

Start Epson Scan.

d Windows 8.1 and 8:
Select the EPSON Scan icon on the desktop, or select EPSON Scan from the Start screen.

(d Windows 7, Vista and XP:
Double-click the Epson Scan icon on the desktop.

d MacOSX:
Select Applications > Epson Software > EPSON Scan.

Select Home Mode.
. EPSON Scan = B )

b7 -? tode;

" EPSON Scan IHDmE Mode "|

Document Type

'?F Phaotoagraph -

Image Type
@ Calor | Grayzscale Blackirwhite
Drestination
Screenweb @) Printer (1 Other
200
Original
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n Select Text/Line Art as the Document Type setting.

" EPSON Scan

K
g EPSON Scan

M ode:

[ Horme Mode

Diocument Type

‘ Teut/Line At

Click Preview.

Image Adjustments
[ | Descresning
[ | Calar Festoration
[T Image Option(]
(8) Text Enhancement

Auto Area Segmentation

’ Brightness. .. ]

Image Type

1 Calar () Grayscals @ Blackiwhite
Destination

(1 Scieenf'eb @ Printer (1 Other
Fezolution; i3':":| " dpi

[ arget Size Criginal

[ | Backlight Corection

|| Dust Remoyal

P

LJ Freview g ari E‘E
—_— ) | [
[] Thumbnai -
l Help ] ’ Configuration. ., ]
E Click Scan.
Image Adjustments
[ ] Descreening

[ | Calar Restoration g
[ Image Option(s]
(@) Test Enhancement

Auta Area Segmentation

[ | Backlight Correction
[] Dust Removal

’ Brightness. .. ]
Lj Preview Hg T ‘ @
[] Thumbnai
Help Configuratiar... Cloze
| | | l
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Click OK.

[ File Save Settings ==
Lecahon
by Docurnerts
9 My Piclures
Other:  Deskiop Erowize
File Mame [Prefix + 2-digit purmiber]
Erefic img Stari Mumber: oo

Imzge Faimat
Tvpe: | JPEG [*ipg) »| [ Opiions..

Delas: Compression Level: [1E]
Encoding Standasd
Embad ICC Prafile: OH

[ Ovesvarite ary fles wilh the same name
[¥] Showe thiz dialog box before rext scan
[ Dpen nage lukder alter searning

[] Showe fadd Page dialog afler scanning.

[ ok J| [ coea | [ Hel

Your scanned image is saved.

Image Adjustment Features

Epson Scan offers a variety of settings for improving color, sharpness, contrast, and other aspects affecting image
quality.

See the Help for more details on Epson Scan.

Histogram Provides a graphical interface for adjusting highlight, shadow, and gamma levels
individually.
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Tone Correction

Provides a graphical interface for adjusting tone levels individually.

Image Adjustment

Adjusts brightness and contrast and the balance of red, green, and blue colors in the
overall image.

Color Palette

Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without
affecting the highlight and shadow areas of the image.

Unsharp Mask

Descreening

Removes rippled patterns (known as moiré) that can appear in subtly shaded image areas
such as skin tones.

Color Restoration
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Backlight Correction

Removes shadows from photos that have too much background light.

Dust Removal

Text Enhancement

Enhances text recognition when scanning text documents.

. Follon the mustructsons |
SCMng Projects vou o
Sobme Problems

B If vou have & problem

wr o ariliaesrs  check b

Follow the mstructions
SCANMNNG Projects vou o
Sohmg Problems

i If vou have a problem 1
l‘l"“il"‘“'ﬂ" -"hl"l’h

Auto Area Segmentation

Makes Black&White images clearer and text recognition more accurate by separating the

text from the graphics.

108 WOUE TN an TR 0ol
e one of those sectd

decumenis or photos: 1 § Doy
# L Btart
"‘\,_} Sep &
&
1 3

Sean
HI‘I!'I'

i inth

HUE VUL LIFREECLLE LY G810 LIIE BEECY
& onz2 of these sestions {or ety

Chan
Color Enhance Enhance a certain color. You can select from red, blue, or green.
sl 1

- FTLLL W . Maintanance
- ' ! o ars bo
§ PPl 1 ot 4 (TS

Techni al Specilical ions Technlcal Specifications

T L 1 i e here for tech al detaib

Basic Scanning from the Control Panel

You can scan documents and send the scanned image from the product to a connected computer. Make sure you have
installed software for the product on your computer and connected to the computer.

1 Place your original on the scanner glass.
= “Placing Originals” on page 24
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Enter the Scan mode from the Home menu.

Select To Computer (JPEG), To Computer (PDF), To Computer (Email), or To Computer (WSD) using 4
or P> to select a menu, and press OK.

= “Scan Mode” on page 69

n Select the computer to which you want to save the scanned images.

Note:
1 You can change the scan settings such as the document type, folder to save, or save format, and frequently-used
scan settings by using Epson Event Manager.

A When the printer is connected to a network, you can select the computer to which you want to save the scanned
image. Up to 20 computers can be displayed on the printer’s control panel.

d  When the computer to which you want to save the scanned images is detected on the network, the initial 15
characters of the computer name are displayed on the control panel. If you set Network Scan Name
(Alphanumeric) on the Epson Event Manager, it is displayed on the control panel.

Press < to start scanning.

Your scanned image is saved.

Scan mode menu list

Refer to the section below for the Scan mode menu list.
= “Scan Mode” on page 69

Basic Scanning from Your Computer

Scanning in Full Auto Mode

Full Auto Mode lets you scan quickly and easily, without selecting any settings or previewing your image. This mode is
useful when you need to scan your originals at 100% size.

Note:
See the Help for more details on Epson Scan.

Place your original(s).

= “Placing Originals” on page 24

Start Epson Scan.

= “Starting Epson Scan Driver” on page 65
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Select Full Auto Mode from the Mode list.

I )

<. EPSON Scan =
L ?1 Maode:

ks EPSON Scan | Full duto Mode -

To zcan in Full Auto Mode, position or load
g Scan the material you want b0 szan, then click,
Scan,

Far Color B estoration and ather options, click the
UELDMIZE. . Customize button and then make the zettings.
Show thiz dialog bow before nest scan.

I@ Y'ou can change the scan mode in the Mode list bo
Q at the top right of the window.
Cloze

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying this screen. To return to this screen, click Cancel in the Scanning dialog box during scanning.
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n Click Scan. Epson Scan starts scanning in Full Auto Mode.

o Y

.. EPSOM Scan 23]

- ode:
k*z EPSON SCB n [MFuII:II.ﬁ.utD Mode *]

Previews and document type recognition iz in progress.

Bauze

Epson Scan previews each image, detects what type of original it is, and selects the scan settings automatically.

Your scanned image is saved.

Scanning in Home Mode

Home Modelets you customize some scanning settings and check the changes you have made in a preview image. This
mode is useful for basic scanning of photos and graphics.

Note:
See the Help for more details on Epson Scan.

Place your original(s).

= “Placing Originals” on page 24

Start Epson Scan.

= “Starting Epson Scan Driver” on page 65
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Select Home Mode from the Mode list.
. EPSON Scan e B
LT Mode:
bea h EPSON Scan IH':"T'E Mode vl
Dacument Tupe
'?X Phaotograph -
Image Type
@ Color () Grayscale (1 Blackiw hite
Deztination
7 Screen/wWeb (1 Other
Bl 300

T arget Size Oriainal

Imane Adjustments
7] Descreening
[7] Calar Restoration
| Image Dption()
(@ Text Enhancernent

Auto Area Segmentation

I Brightness. .. |

‘J Preview

[¥] T humbrni

[] Backlight Corection
[7] Dust Bemaval

(o]

I Configuratior... |

Select the Document Type setting.

Select the Image Type setting.

Click Preview.

Click Scan.

oo oS
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E In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Office Mode

Office Mode lets you quickly scan text documents without previewing your image.

Note:
See the Help for more details on Epson Scan.

Place your original(s).

= “Placing Originals” on page 24

Start Epson Scan.

= “Starting Epson Scan Driver” on page 65
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Select Office Mode from the Mode list.

Scanning

. EPSON Scan
|
he )

i

EPSON Scan

=l & ]
-

Mode:
| Difice Mode

Image Type
(@ Calor

Deztination
Document Source:

Size:

Orientation:

Rezolution:

Image Adjustments

() Grayscale

() Blackiwhite

)

-

[Scanner Glazs

Letter[8.5 %17 in]

300 v i

[7] Dezcreening

[ Image Option
(@ Text Enhancement

Auto Area Seqmentation

Color Enhance: Fed
Brightness: {}
Contrast: J

‘ ‘J Preview ‘ ‘ ﬂ Scan ‘ ‘ L;@‘

’ Configuratior. ..

|

1

Select the Image Type setting.

Select the Document Source setting.

Select the size of your original as the Size setting.

Click Scan.

ol ool
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E In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Professional Mode

Professional Mode gives you total control of your scanning settings and lets you check the changes you have madeina
preview image. This mode is recommended for advanced users.

Note:
See the Help for more details on Epson Scan.

Place your original(s).

= “Placing Originals” on page 24

Start Epson Scan.

= “Starting Epson Scan Driver” on page 65
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Select Professional Mode from the Mode list.

.. EPSON Scan o] @ [
i |
-1 Mode:
.k‘ : EPSON Scaﬂ [PrnfeaaiunalMDde V]
Settings
Mame: Current Setting -

Original
Document Tupe: Reflactive -
Document Source:; Scanner Glazs -
Auto Expozure Type: Photo -

Destination
Image Type: 24-bit Calar -
Rezolution: 00 * dpi
Document Size: W 280l H| 11.70| | in.

Original
Adjustments
" - Fezet

Unzharp Mazk
[T Descreening
[ Calor Restaration

[T Backlight Comection

[ Dust Remowal

‘d Preview ‘ ‘ ) Son @‘

[ Thumbnail
[ Help ] [ Configuratiar... ] [ Cloze ]

Select the type of original(s) you are scanning as the Document Type setting.

Select the Document Source setting.

If you select Reflective as the Document Type setting, select Photo or Document as the Auto Exposure Type
setting.

oo i~
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Scanning

Select the Image Type setting.

Select an appropriate resolution for your original(s) as the Resolution setting.

Click Preview to preview your image(s). The Preview window opens and displays your image(s).
= “Previewing and Adjusting the Scan Area” on page 58

Select the size of the scanned image(s) as the Target Size setting if necessary. You can scan your images at their
original size, or you can reduce or enlarge their size by selecting Target Size.

Adjust the image quality if necessary.
= “Image Adjustment Features” on page 47

Note:
You can save the settings you make as a group of custom settings with a Name, and later apply these custom settings
when scanning. Your custom settings are also available in Epson Event Manager.

See the Help for more details on Epson Event Manager.

Click Scan.

In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Previewing and Adjusting the Scan Area

Selecting a preview mode

Once you have selected your basic settings and resolution, you can preview your image and select or adjust the image
area in a Preview window. There are two types of preview.

4

Normal preview displays your previewed image(s) in their entirety. You can select the scan area and make any
image quality adjustments manually.

Thumbnail preview displays your previewed image(s) as thumbnail(s). Epson Scan automatically locates the
edges of your scan area, applies automatic exposure settings to the image(s), and rotates the image(s) if necessary.
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Note:
0 Some of the settings that you change after previewing an image are reset if you change the preview mode.

1 Depending on your document type and the Epson Scan mode you are using, you may not be able to change the preview
type.

O Ifyoupreview image(s) without the Preview dialog displayed, image(s) are displayed in the default preview mode. If you
preview with the Preview dialog displayed, image(s) are displayed in the preview mode that was displayed just before
previewing.

0 To resize the Preview window, click and drag the corner of the Preview window.

0 See the Help for more details on Epson Scan.

Creating a marquee

A marquee is a moving dotted line that appears on the edges of your preview image to indicate the scan area.
Do one of the following to draw a marquee.

4 To draw the marquee manually, position the pointer in the area where you want to place the corner of your
marquee and click. Drag the cross-hairs over the image to the opposite corner of the desired scan area.

4 To draw the marquee automatically, click the auto locate icon. You can only use this icon when you are
viewing a normal preview and you only have one document on the scanner glass.

4 To draw the marquee at a specified size, type in a new width and height in the Document Size setting.

[ For best results and image exposure, make sure all sides of the marquee are located inside the preview image. Do
not include any areas around the preview image in the marquee.

Adjusting a marquee

You can move the marquee and adjust its size. If you are viewing a normal preview, you can create multiple marquees
(up to 50) on each image to scan different image areas as separate scan files.

§4‘|-P To move the marquee, position your cursor inside the marquee. The pointer becomes a hand. Click
and drag the marquee to the desired location.

_ _I_ . To resize the marquee, position your cursor over the edge or corner of the marquee.

The pointer becomes a straight or angled double-arrow. Click and drag the edge or corner to the
desired size.
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To create additional marquees of the same size, click this icon.

To delete a marquee, click inside the marquee and click this icon.

To activate all marquees, click this icon.

Note:
|
marquee.
|
|

inside the last marquee you drew will be scanned.

To restrict the movement of the marquee to vertical or horizontal only, hold down the Shift key as you move the

To restrict the size of the marquee to the current proportions, hold down the Shift key as you resize the marquee.

Ifyou draw multiple marquees, make sure you click All in the Preview window before you scan. Otherwise, only the area

Various Types of Scanning

Scanning a Magazine

First of all, place your magazine and start Epson Scan.

= “Starting a Scan” on page 45

L
vy

|8
S

EPSOM Scan

EPSOMN Sran

Mode:

: Home Mods

Document Type

=
— iiq] agazine

Image Type

@ Color () Grayseale

Drestrvation
) Scieenfw’sb @ Prinler

00

(7} Blackbwhite

) Qthes

Target Sige: B:gnal

Imnage Adustments
[¥] Descreening
Codar Restoration
[ Image Dptionf)
(@) Teuwt Erhancement

Aubo Sres Segmenlzhon

Biightness...

1

L

Backlight Conection
Dzt Remonal

Thumbnad

| b | [ Cconbpuan.

] o o

=y,

Clase

Select Home Mode from the Mode list.
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Click Preview.

N AN

Scanning

Select Magazine as the Document Type setting.

Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

Click Scan.

£l

. File Save Settings

Locatian
2 My Documents
@ My Fictued
1 Otthes: Desklop Erows
File Mame [Prelfix + 3-digil ramier]
Erefic ifng Start Mumber; oo+
e Emrms st
{ e (POF () || opiiens.,
Delas: Papes Soe Ackhus Image Sae
Orierdation: Poslrait

Margi: (Lelt, TopH 0.00in.. 0.0Cn.]
Page Numbear: Save File With 2l Pages
Comprezsion Level ; Standard Cormprestion

|7 Oiveswnite ang fles with the same name
[#] Show this dialog box befee nest scan
|| Dpen enage folder aller seanning

[¥] Show gdd Page dialog after scanning,

Lo 1) |

Cancel | | Hep

E Select PDF as the Type setting, and then click OK.

Your scanned image is saved.

61




User’s Guide

Scanning

Scanning Multiple Documents to a PDF File

First of all, place your document and start Epson Scan.
= “Starting a Scan” on page 45

< EPSON Scan =N E=R|
b 2
@ Mode:
1 hA? EPCNN Qran r -
— | Professional Mode V]
._.J
Settings
Mame: Current Setting -

Original
Document Tupe: Reflective -
2 {Docgment Source: Scanner Glasz - )
Ato Expozure Type: Phota v]
Destination
Image Type: 24-bit Colar -
Fezolution: 300 ~ dpi
Document Size: W BEO|H| 11.70(|in.
Target Size: Original A‘I
Adiustments

Unsharp Mask
] Descreening

[] Color Fiestoration
|| B acklight Carection

] Dust Remaoval

il =) L=

| . |
3 — d Preview Sean ==
[] Thumbnail ﬂ lEJ
Help Caonfiguration... LCloze
l ] | ] )

Select Professional Mode from the Mode list.

Select the Document Source setting.

Click Preview.

Adjust the exposure, brightness, and other image quality settings.

HENE

See the Help for more details on Epson Scan.
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Scanning

-.-» File Save Settings
Lecatian
) My Documerts
y Other:  Desklop
Filz Mame [Prefix + 3-digit number]
Prefic i Stark Mumber:

ey )

/

= Les  [POFCe® -]

Details: Papet Size: Actusl Image Size
Oiierdation: Posirait
Marai: Lelt, TopH 0.00ir.. 0.0Cn.]
Page Numbar Save File With 21l Pages
Comprezzion Level : Stardard Cormpression

|71 Dveswte any hles with the same name
[¥] Show this dialog box befoee nest scan
|/ Dpen image folder after scanning

[ Show fidd Page dialog afler scanning.

[k 1] [ ceca |

E Select PDF as the Type setting, and then click OK.

Note:

If the Show Add Page dialog after scanning check box is cleared, Epson Scan automatically saves your document
without displaying the Add Page Confirmation window.

Epson Scan starts scanning your document.

8

Add Page Confirmation

e, Scanning complete.
I@I Do you want to continue scanning and add more pages™?

Select Edit Page to finizh zcanning and edit the pages

before zaving the file.

Select Save File to finish scanning and save the file

without editing the pages.

| Addpage | u Edit page I l Save File ]]_

E If you want to scan more pages, click Add page.

Load the document and scan again, repeating as necessary for each page.

If you have finished scanning, go to step 9.
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E Click Edit page or Save File.

Edit page Select this button if you want to delete or reorder any of the pages. Then use the icons on the
bottom of the Editing Page window to select, rotate, reorder, and delete pages.
See the Help for more details on Epson Scan.

S =
Tl Pager 4

HE@ CnE .-

Click OK when you are finished editing your pages.

Save File Select this button when you are finished.

The pages are saved in one PDF file.

Scanning a Photo

First of all, place your photo on the scanner glass and start Epson Scan.
= “Starting a Scan” on page 45

< EPSONScan =
b Mode:
1 i ERPCOIM Cran Home Mode _l|
Document Type
2 — '@] Frategraph -
Irnage Type
@ Color () Grayscale (7} Blackbwhite
Diestiation
_ Scieendw’eh @ Prinler ) Oithes
300
Target Sigec E_ﬂmml t-_l A
Image Adustments
7] Descreening | Backlight Conection
| Colar Resteration | Dust Rerncval
Image Ophanis] e 4
@) Text Enhancement
Bube fres Seqrmenlahon
Biightness... |
3 ——1 _..L_J T 5
|.r Thurbnad
[ Heb | [ Corfoursen..
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Select Home Mode from the Mode list.

Select Photograph as the Document Type setting.

Click Preview.

Adjust the exposure, brightness, and other image quality settings.

HENE

See the Help for more details on Epson Scan.

Click Scan.

£l

<. File Save Settings =
Location
) My Documenks

@ My Ficlues
Other:  Desklop Erowse

File Mame [Prefix + 3-digit rumber]

Prefix img Start Mumber: o
I nna Earea st

= Type: [JPEG I7ipal || oplions.,
Delais: Lompression Level [16]

Encoding: Standaed
Errled ICC Profile: OH

|7 Oiveswnite ang fles with the same name
[#] Show this dialog box befee nest scan

| Dpen enage [okder alter searning

[¥] Show gdd Page dialog after scanning,

ok | [ Comed | [ Hep |

E Select JPEG as the Type setting, and then click OK.

Your scanned image is saved.

Software Information

Starting Epson Scan Driver

This software lets you control all aspects of scanning. You can use this as a standalone scanning program or use it with
another TWAIN-compliant scanning program.
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How to start

(d Windows 8.1 and 8:
Select the Epson Scan icon on the desktop.
Or, select Epson Scan from the Start screen.

1 Windows 7, Vista and XP:
Double-click the EPSON Scan icon on the desktop.
Or, select the start button icon or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON
Scan.

d MacOSX:
Select Applications > Epson Software > EPSON Scan.

How to access the help

Click the Help button on the Epson Scan driver.

Starting Other Scanning Software

Note:
Some scanning software may not be included in some countries.

Epson Event Manager

This lets you assign any of the product buttons to open a scanning program. You can also save frequently used
scanning settings, which can really speed up your scanning projects.

How to start

1 Windows 8.1 and 8:
Right-click on the Start screen, or swipe from the bottom or top edge on the Start screen, and select All apps >
Epson Software > Event Manager.

d  Windows 7, Vista and XP:
Select the start button or Start > All Programs or Programs > Epson Software > Event Manager.

d MacOSX:
Select Applications > Epson Software, and then double-click the Launch Event Manager icon.

How to access the help

1 Windows:
Click thel“#] icon in the upper right corner of the screen.

d MacOSX:
Click menu > Help > Epson Event Manager Help.
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Basic Scanning from Smart Devices

EpsoniPrintisan application that allows you to scan photos and documents from a smart device, such as a smartphone
or tablet, that is connected to the same wireless network as your printer. You can save the scanned data on a smart
device or to Cloud services, send it by email, or print it.

You can install Epson iPrint on your smart device from the following URL or QR code.

http://ipr.to/a

Using Epson iPrint
Start Epson iPrint from your smart device and select the item you want to use from the home screen.

The following screens are subject to change without notice.

= 19:41

Epson iPrint

e— Printer is not selected. ,

Tap here to select a printer.

ho >

[F7]| Photos | . e

HEP’ Saved Documents

fijl Online Storage

I,»l Web Page Print
o — Q Scan

(1) Home screen displayed when the application is started.

®

Displays information on how to setup the printer and a FAQ.

(3] Displays the screen whereyou can select the printer and make printer settings. Once you have selected the printer,you do
not need to select it again from the next time.

(4] Displays the scanning screen.

(5] Displays the screen where you can make scan settings such as resolution.
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Displays scanned images.

Starts scanning.

Displays the screen where you can save scanned data to a smart device or Cloud services.

Displays the screen where you can send scanned data by email.

e 6 06 0 0

Displays the screen where you can print scanned data.
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Menu List of Control Panel

You can use this product as a printer, copier, and scanner. When using one of these functions, except the printer
function, select your desired function by selecting the corresponding Mode on the control panel. Each mode’s main
screen appears as you select the mode.

Copy Mode

Press ¥ to see the menu.

Menu Setting item and description
Settings Reduce/Enlarge Actual Size, Auto Fit, Custom
Custom Size Specify a percentage to reduce or enlarge your copy. Disabled

when Auto Fit is selected.

Paper Size A4, 10x15cm(4x6in), 13x18cm(5x7in)
Paper Type plain papers, Prem, Glossy

Quality Draft, Standard Quality, Best

Density -4to +4

Print Photos Mode

Press ¥ to see the menu.

Menu Setting item and description

Settings Paper Size™’ 10x15cm(4x6in), 13x18cm(5x7in), A4
Paper Type™! Prem, Glossy
Quality™ Standard Quality, Best

*1 If you have selected multiple photos, these settings are applied to the all photos.

Scan Mode

Menu Setting and Options
To Computer (JPEG) = “Basic Scanning from the Control Panel” on page 49
To Computer (PDF)

To Computer (Email)
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Menu

Setting and Options

To Computer (WSD)

This feature is only available for English versions of Windows 8.1/8/7/Vista.

Personal Stationery Mode

Menu

Setting item and description

Lined Papers

Lined Papers

You can print lined paper, graph paper, or music
paper.

Writing Papers

Writing Papers

You can print your original lined papers with or
without a photo set as the background.

Calendar

Calendar

You can print monthly or weekly calendars. For
monthly calendars, you can specify the year and
month.

Setup Mode

Menu

Setting item and description

Maintenance

Nozzle Check

Prints anozzle check pattern to check the condition of
the print head.

Head Cleaning

Cleans the print head to improve the condition of the
print head.

Head Alignment

Adjusts the alignment of the print head.

Reset Ink Levels

Select to reset ink levels.

Paper Guide Cleaning

= “Cleaning the interior of the product” on
page 87

Printer Setup

Paper Source Settings

Paper Setup: Select the paper size and paper type you
loaded.You canalsoselect these when loading paper.
Paper Setting Alert: Alerts you when the paper
settings of a print job differ from the settings stored in
the printer.

Paper Configuration: Automatically displays the
paper settings screen when paperisloaded. AirPrintis
not available when disabled.

Power Off Timer

= “Saving Power” on page 84

Language You can change the language displayed on the LCD
panel.
Sleep Timer = “Saving Power” on page 84
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Menu

Setting item and description

Network Settings

Print Status Sheet You can see the current network settings and print a
network status sheet.

Wi-Fi Setup See the online Network Guide. You can access the
Wi-Fi Setup menus directly by selecting Wi-Fi Setup
from the Home menu.

Connection Check You can check the network connection status, and
print the report. If there is any problem with the
connection, the report helps you find the solution.

Epson Connect Services

Google Cloud Print
Services

You can suspend or resume the Epson Connect or Google Could Print service, or cancel using the
services (restore the default settings).

See the Epson Connect portal website for more details.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

File Sharing

Write access from USB Select the connection method between a printer and
a computer when giving write access to the memory
Write access from Network card inserted in the printer. Read and write access is

given to the computer with the priority connection.
Only read access is given to other computers.

Restore Default Settings

Network Settings Resets the selected settings to their defaults.

All except Network

All Settings

Wi-Fi Setup Mode

Menu

Setting item and description

Wi-Fi Setup Wizard

Select an SSID, enter a password, and then connect the printer to a wireless (Wi-Fi) network.

Push Button (WPS)

Connects the printer to a wireless (Wi-Fi) network by pressing a WPS push button on a wireless
router.

PIN Code (WPS)

In the wireless router utility, enter the PIN code displayed on the printer’s screen and connect the
printer to a wireless (Wi-Fi) network.

Wi-Fi Auto Connect

Connects the printer easily to a wireless (Wi-Fi) network.

Disable Wi-Fi

Disables the connection by turning the Wi-Fi off without deleting the network information. To
enable the connection, set up the wireless (Wi-Fi) network again.

Wi-Fi Direct Setup

Connects the printer to a wireless (Wi-Fi) network without a wireless router.
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Refilling Ink

Ink Bottle Safety Instructions, Precautions, and
Specifications

Safety instructions

Observe the following when handling the ink:

[ Keep ink bottles and the ink tank unit out of the reach of children. Do not allow children to drink from or handle
the ink bottles and ink bottle cap.

4 Do not tilt or shake an ink bottle after removing its seal; this can cause leakage.

4 Be careful not to touch any ink when you handle the ink tanks, ink tank caps, and opened ink bottles or ink bottle
caps.
If ink gets on your skin, wash the area thoroughly with soap and water.
If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a
thorough flushing, see a doctor immediately.
If ink gets into your mouth, spit it out immediately and see a doctor right away.

Precautions on refilling ink

Read all of the instructions in this section before refilling ink.

[ Use ink bottles with the correct part number for this product.
= “Product Information” on page 117

[d  Epson recommends the use of genuine Epson ink bottles. Epson cannot guarantee the quality or reliability of
non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic product behavior.

4 Other products not manufactured by Epson may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic product behavior.

4 This product requires careful handling of ink. Ink may splatter when the ink tanks are filled or refilled with ink. If
ink gets on your clothes or belongings, it may not come off.

d  Tomaintain optimum print head performance, some ink is consumed from all ink tanks not only during printing
but also during maintenance operation such as print head cleaning.

4 Do not open the ink bottle package until you are ready to fill the ink tank. The ink bottle is vacuum packed to
maintain its reliability. If you leave an ink bottle unpacked for along time before using it, normal printing may not

be possible.

1 Ifanyoftheink tanks are not filled up to the lower line, refill the ink soon. Continued use of the product when the
ink level is below the lower line on the tanks could damage the product.
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After bringing an ink bottle inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

Store ink bottles in a cool, dark place.

Store the ink bottles in the same environment as the product. When storing or transporting an ink bottle after
removing its seal, do not tilt the bottle and do not subject it to impacts or temperature changes. Otherwise, ink may
leak even if the cap on the ink bottle is tightened securely. Be sure to keep the ink bottle upright when tightening
the cap, and take measures to prevent ink from leaking when you transport the bottle.

Ink bottle specifications

4

4

Epson recommends using the ink bottle before the date printed on the package.
The ink bottles packaged with your product are partly used during initial setup. In order to produce high quality
printouts, the print head in your product will be fully charged with ink. This one-off process consumes a quantity

of ink and therefore these bottles may print fewer pages compared to subsequent ink bottles.

Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

Although the ink bottles may contain recycled materials, this does not affect product function or performance.

When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the paper
type or print quality settings. This is because a mixture of color inks is used to create black.

Checking the Ink Levels

To confirm the actual ink remaining, visually check the ink levels in all of the product’s tanks.

Important:
Ifany of the ink tanks are not filled up to the lower line, fill them to the upper line on the ink tank. Continued use of the
product when the ink level is below the lower line on the tanks could damage the product.

Ak

Refilling the Ink Tanks

Note:
The illustrations show how to refill the ink tank at the far left. However, the instructions are the same for all of the inks.
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Enter Setup mode from the Home menu on the LCD screen.

Select Maintenance.
Select Reset Ink Levels.

n Press .

Unhook the ink tank unit from the product and lay it down.

Note:
Do not pull the tubes.

E Open the ink tank unit cover, and then remove the cap of the ink tank.

Note:
A Be careful not to spill any ink.

[ Make sure that the color of the ink tank matches the ink color that you want to refill.

TS
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Snap off the top of the cap, remove the cap of the ink bottle, remove the seal from the bottle, and then install the
cap.

jeggg

» »%»

Close the ink bottle cap tightly; otherwise ink may leak.

Note:
Do not dispose of the top of the cap. If any ink remains in the ink bottle after refilling the tank, use the top of the cap to
seal the ink bottle cap.

E Refill the ink tank with the correct colored ink up to the upper line on the ink tank.
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Note:

Ifany ink remains in the ink bottle after filling the ink tank up to the upper line, install the cap securely and store the
ink bottle upright for later use.

M\

S s

@

E Close the cap onto the ink tank securely.

(
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Check the color that you refilled to the upper line, and then select it and follow the instructions on the LCD
screen to reset the ink levels.

Note:
You can reset the ink levels even if you did not fill the ink to the upper line. However, this product cannot generate
notifications and stop operations before ink levels drop below the lower line.
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Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by
checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or from the product by
using the buttons.

Using the Nozzle Check utility for Windows
Follow the steps below to use the Nozzle Check utility.

Make sure that no warnings or errors are indicated in the control panel.
Make sure that A4-size paper is loaded in the sheet feeder.

Right-click the product icon on the taskbar, then select Nozzle Check.

If the product icon does not appear, refer to the following section to add the icon.
= “From the shortcut icon on the taskbar” on page 29

n Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

Make sure that no warnings or errors are indicated in the control panel.
Make sure that A4-size paper is loaded in the sheet feeder.

Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 30

& ™

Click the Nozzle Check icon.

Follow the on-screen instructions.

gl B
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Using the control panel
Follow the steps below to check the print head nozzles using the product control panel.

Make sure that no warnings or errors are indicated in the control panel.
Make sure that A4-size paper is loaded in the sheet feeder.

Enter Setup mode from the Home menu.

Select Maintenance.

Select Nozzle Check and follow the instructions in the LCD screen to print a nozzle check pattern.

BN AN

Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality
problems, such as gaps or missing segments in the test lines, the print head is fine.

——

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a

misaligned print head.
~ —~—

= “Cleaning the Print Head” on page 79
= “Aligning the Print Head” on page 81

Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve these problems by
cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer driver or from the
product by using the buttons.
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n Important:

d Do not open the printer cover or turn off the product during head cleaning. If the head cleaning is incomplete, you
may not be able to print.

[  If print quality does not improve after repeating this procedure three times, turn the product off and wait for at
least twelve hours. Then run the nozzle check again and repeat head cleaning if necessary. If print quality has still
not improved, contact Epson support.

Note:
[ Because print head cleaning uses some ink from all tank, clean the print head only if quality declines; for example, if the
printout is blurry or the color is incorrect or missing.

0 Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.

(]

When ink is low you may not be able to clean the print head. Prepare a new ink bottle.

U To maintain print quality, we recommend printing a few pages on a regular basis.

Using the Head Cleaning utility for Windows
Follow the steps below to clean the print head using the Head Cleaning utility.

Make sure that no warnings or errors are indicated in the control panel.

Right-click the product icon on the taskbar, then select Head Cleaning.

If the product icon does not appear, refer to the following section to add the icon.
= “From the shortcut icon on the taskbar” on page 29

Follow the on-screen instructions.

Using the Head Cleaning utility for Mac OS X
Follow the steps below to clean the print head using the Head Cleaning utility.

Make sure that no warnings or errors are indicated in the control panel.

Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 30

Click the Head Cleaning icon.

n Follow the on-screen instructions.

Using the control panel

Follow the steps below to clean the print head using the product control panel.
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Make sure that no warnings or errors are indicated in the control panel.

Enter Setup mode from the Home menu.

Select Maintenance.

Select Head Cleaning.

Follow the instructions on the LCD screen to continue.

Bl EANER

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem by using the
Print Head Alignment utility in your printer driver or by using the product buttons.

Refer to the appropriate section below.

Note:
Do not press @ to cancel printing while printing a test pattern with the Print Head Alignment utility.

Using the Print Head Alignment utility for Windows
Follow the steps below to align the print head using the Print Head Alignment utility.

Make sure that no warnings or errors are indicated in the control panel.
Make sure A4-size paper is loaded in the sheet feeder.

Right-click the product icon on the taskbar, then select Print Head Alignment.

If the product icon does not appear, refer to the following section to add the icon.
= “From the shortcut icon on the taskbar” on page 29

n Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X
Follow the steps below to align the print head using the Print Head Alignment utility.

Make sure that no warnings or errors are indicated in the control panel.
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Make sure A4-size paper is loaded in the sheet feeder.

Access the Epson Printer Utility 4.

& N

= “Accessing the printer driver for Mac OS X” on page 30

Click the Print Head Alignment icon.

Follow the on-screen instructions to align the print head.

gl

Using the control panel
Follow the steps below to align the print head using the product control panel.

Make sure that no warnings or errors are indicated in the control panel.

Make sure that A4-size paper is loaded in the sheet feeder.

Enter Setup mode from the Home menu.

Select Maintenance.

Select Head Alignment and follow the instructions in the LCD screen to print the patterns.

Find the most solid pattern in each of #1 to #4 groups.

Bl BN AN

#1

m
3

0K

m
5

Enter the pattern number for the most solid pattern in #1 group.

E Repeat step 7 for the other groups (#2 to #4).

E Finish aligning the print head.

Replacing Ink inside the Ink Tubes

Ifyou have not used the product for along time and notice banding or missing colors in the printouts, you may need to
replace the ink inside the ink tubes to solve the problem.

82



User’s Guide

Maintaining Your Product and Software

The Power Ink Flushing utility allows you to replace all of the ink inside the ink tubes.

Important:
This function consumes a lot of ink. Before using this function, make sure there is enough ink in the product’s ink tanks.
If there is not enough ink, refill the ink tanks.

Note:

0 This function effects the service life of the ink pads. Ink pads reach their capacity earlier by running this function.
Contact Epson Support or an authorised Epson service provider to request replacement before the end of their service
life. It is not a user-serviceable part.

0 After using the Power Ink Flushing utility, turn the product off and wait for at least twelve hours. Using this function
improves the print quality after twelve hours, however it cannot be used again within twelve hours of the last use. If you
still cannot solve the problem after trying all of the methods above, contact Epson support.

Using the Power Ink Flushing utility for Windows
Follow the steps below to use the Power Ink Flushing utility.

Make sure that no warnings or errors are indicated in the control panel.

Access the printer driver.

= “Accessing the printer driver for Windows” on page 29

Click the Maintenance tab, then click the Power Ink Flushing button.

n Follow the on-screen instructions.

Using the Power Ink Flushing utility for Mac OS X
Follow the steps below to use the Power Ink Flushing utility.

Make sure that no warnings or errors are indicated in the control panel.

Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 30

Click the Power Ink Flushing icon.

n Follow the on-screen instructions.
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Saving Power

The product enters sleep mode or turns off automatically if no operations are performed for a set period.

You can adjust the time before power management is applied. Any increase will affect the product’s energy efficiency.
Please consider the environment before making any change.

Follow the steps below to adjust the time.

For Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 29

Click the Maintenance tab, and then click the Printer and Option Information button.

Select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the Power Off Timer setting, and click
the Send button.

Select 3 minutes, 5 minutes, 10 minutes, or 15 minutes as the Sleep Timer setting, and click the Send button.

Click the OK button.

For Mac OS X

BN EAN A

Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 30

Click the Printer Settings button. The Printer Settings screen appears.

Select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the Power Off Timer setting.

Select 3 minutes, 5 minutes, 10 minutes, or 15 minutes as the Sleep Timer setting.

Click the Apply button.

Using the control panel

Enter Setup mode from the Home menu.

Select Printer Setup.
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Select Power Off Timer.

Select Off, 30minutes, 1h, 2h, 4h, 8h, or 12h.

Select Sleep Timer.

Select 3minutes, 5minutes, 10minutes, or 15 minutes.

oo~ N

Quieter Printer Operations

You can make printer operations quiet without changing the print quality. However, printing speed might be reduced.

For Windows

1 Access the printer settings.
= “Accessing the printer driver for Windows” on page 29

In the Main window, select Off or On as the Quiet Mode.

For Mac OS X

Click System Preferences on the Apple menu.

Click Printers & Scanners (for Mac OS X 10.9), Print & Scan (for Mac OS X 10.8 or 10.7) or Print & Fax (for
Mac OS X 10.6 or 10.5), and then select your product from the Printers list box.

Click Options & Supplies, and then Driver.

n Select Off or On as the Quiet Mode.

Checking the Number of Sheets of Paper Fed

You can check the number of sheets of paper fed from the printer driver.

Click the Printer and Option Information button on your printer driver’s Maintenance window (for Windows) or on
the Epson Printer Utility 4 (for Mac OS X).
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Managing the Printer Status or Settings on a Web
Browser

Epson Connect Service

Using Epson Connect, you can print from your smartphone, tablet PC, or laptop, anytime and practically anywhere.

The following features are available for your printer.

Email Print Epson iPrint remote print Scan to Cloud Remote Print Driver

v v - 4

See the Epson Connect portal website for details.
https://www.epsonconnect.com/

http://www.epsonconnect.eu (Europe only)

Web Config

Web Config is an application that allows you to manage the printer status or settings on a Web browser from a
computer or smart device. You can confirm the printer status or change the network and printer settings. To use the
Web Config, connect the printer and device to the same network.

Note:
The following browsers are supported.

os Browser
Windows XP or later Internet Explorer 8 or later, Firefox™!, Chrome™!
Mac OS X v10.6.x or later Safari*!, Firefox™!, Chrome™!
i0S"1"2 Safari"!
Android 2.3 or later"2 Default browser
Chrome OS™ Default browser

*1 Use the latest version.

*2 Displays basic settings only

Running Web Config on Windows
Access View devices and printers in Windows.
Windows 8.1 and 8:

Select Desktop > Settings > Control Panel > View devices and printers in Hardware and Sound (or
Hardware).
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Windows 7:
Click the start button, and select Control Panel > View devices and printers in Hardware and Sound.

Windows Vista:
Click the start button, and select Control Panel > Printers in Hardware and Sound.

Right-click on your printer and select Properties.

Select the Web Service tab and click the URL.

Running Web Config on Mac OS X

Select System Preferences from the ‘ menu > Printers & Scanners (or Print & Scan, Print & Fax), and then
select the printer.

Click Options & Supplies > Show Printer Webpage.

Cleaning the Product

Cleaning the exterior of the product

To keep your product operating at its best, clean it thoroughly several times a year by using the following instructions.

n Important:

Never use alcohol or thinner to clean the product. These chemicals can damage the product.

Note:
Close the paper support and the output tray when you are not using the product to protect the product from dust.

A Use a soft, dry, clean cloth to clean the LCD screen. Do not use liquid or chemical cleaners.

4 Useasoft,dry, clean cloth to clean the surface of the scanner glass. If the glass surface is stained with grease or some
other hard-to-remove material, use a small amount of glass cleaner and a soft cloth to remove it. Wipe off all
remaining liquid.

[d Do not press the surface of the scanner glass with any force.

[d  Becareful notto scratch or damage the surface of the scanner glass, and do not use ahard or abrasive brush to clean
it. A damaged glass surface can decrease the scan quality.

Cleaning the interior of the product

To keep your print results at their best, clean the roller inside by using the following procedure.
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Caution:
Be careful not to touch the parts inside the product.

n Important:
A

Be careful to keep water away from the electronic components.
d Do not spray the inside of the product with lubricants.

4 Unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is
needed.

Make sure that no warnings or errors are indicated in the control panel.

Load a A4-size plain paper in the sheet feeder.

Enter Setup mode from the Home menu.

Select Maintenance.

Select Paper Guide Cleaning.

Press ® to load paper. Repeat this procedure until the paper is not smeared with ink.

BBl NER

Transporting the Product

Ifyouneed to transport your printer some distance, carefully prepare and repack it as described below. Use the original
box and packing materials, or a similar box that holds the printer snugly.

g Important:

(A When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

(A When storing or transporting an ink bottle after removing its seal, do not tilt the bottle and do not subject it to
impacts or temperature changes. Otherwise, ink may leak even ifthe cap on the ink bottle is tightened securely. Be
sure to keep the ink bottle upright when tightening the cap, and take measures to prevent ink from leaking when
you transport the bottle.

Remove all paper from the sheet feeder and make sure the product is off.
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Open the scanner unit and make sure the print head is in the home position on the right.

Note:
Ifthe print head is not in the home position on the right, turn on the product and wait until the print head locks in the
far right position. Then turn off the product.

Secure the print head to the case with tape as shown, then close the scanner unit.

Note:
Do not place tape on the white flat cable inside the product.

n Unplug the power cord from the outlet, then disconnect the USB cable from the product.

Close the paper support and the output tray.
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E If you have raised the control panel, pull the release lever on the rear of the control panel until it clicks, and then
lower the control panel to store.

Unhook the ink tank unit from the product and lay it down, and then make sure to install the cap onto the ink
tank securely.

E Hook the ink tank unit onto the product.

E Repack the product in the box, using the protective materials that came with it.

Note:
A Keep the product level during transport. Otherwise, ink may leak.

A Ifyou notice a decline in print quality, run a cleaning cycle or align the print head.

A Do not put opened ink bottles in the box with product.

Checking and Installing Your Software

Checking the software installed on your computer

To use the functions described in this User’s Guide, you need to install the following software.

(A Epson Driver and Utilities
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4 Epson Easy Photo Print
1 Epson Event Manager

Follow the steps below to check that the software is installed on your computer.

For Windows
Windows 8.1 and 8: Select Control Panel from Settings.
Windows 7 and Vista: Click the start button and select Control Panel.
Windows XP: Click Start and select Control Panel.
Windows 8.1, 8, 7 and Vista: Select Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

Check the list of currently installed programs.

For Mac OS X

Double-click Macintosh HD.

Double-click the Epson Software folder in the Applications folder and check the contents.

Note:
A The Applications folder contains software provided by third parties.

A To check that the printer driver is installed, click System Preferences on the Apple menu and then click Print & Scan
(for Mac OS X 10.9, 10.8 or 10.7) or Print & Fax (for Mac OS X 10.6). Then locate your product in the Printers list
box.

Installing the software

Insert the product software disk that came with your product and select the software you want to install on the Software
Select screen.

If you are using Mac OS X, or if your computer does not have a CD/DVD drive, go to the following Epson website to
download and install the software.
http://support.epson.net/setupnavi/

Uninstalling Your Software

You may need to uninstall and then reinstall your software to solve certain problems or if you upgrade your operating
system.
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See the following section for information on determining what applications are installed.

= “Checking the software installed on your computer” on page 90

For Windows

Note:
0 For Windows 8.1, 8, 7 and Vista, you need an administrator account and password if you log on as a standard user.

0 For Windows XP, you must log on to a Computer Administrator account.

£ e

8

Turn off the product.

Disconnect the product’s interface cable from your computer.

Do one of the following.
Windows 8.1 and 8: Select Control Panel from Settings.
Windows 8.1, 8, 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

Do one of the following.
Windows 8, 7 and Vista: Select Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

Select the software you want to uninstall such as your product’s driver and the application from the list
displayed.

Do one of the following.
Windows 8.1, 8 and 7: Select Uninstall/Change or Uninstall.

Windows Vista: Click Uninstall/Change or Uninstall, and then click Continue in the User Account Control
window.

Windows XP: Click Change/Remove or Remove.

Note:
If you chose to uninstall your product’s printer driver in step 5, select the icon for your product and then click
OK.

When the confirmation window appears, click Yes or Next.

Follow the on-screen instructions.
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In some cases, a message may appear to prompt you to restart your computer. If so, make sure I want to restart my
computer now is selected and click Finish.

For Mac OS X

Note:

0 To uninstall your software you need to download the Uninstaller.
Access the site at:
http://www.epson.com
Next, select the support section of your local Epson Web site.

U To uninstall applications, you must log on to a Computer Administrator account.
You cannot uninstall programs if you log on as a limited account user.

0 Depending on the application, the Installer may be separated from the Uninstaller.

Quit all running applications.

Double-click the Uninstaller icon in your Mac OS X hard drive.

Select the check boxes for the software you want to uninstall, such as the printer driver and the application, from
the list displayed.

n Click Uninstall.

Follow the on-screen instructions.

If you cannot find the software you want to uninstall in the Uninstaller window, double-click the Applications folder
in your Mac OS X hard drive, select the application you want to uninstall, and then drag it to the Trash icon.

Note:
Ifyouuninstall the printer driver and the name of your product remains in the Print & Scan (for Mac 0S X 10.9, 10.8 01 10.7)
or Print & Fax (for Mac OS X 10.6) window, select the name of your product and click the - remove button.
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Transferring Data Using an External Storage
Device

You can use the product’s memory card slot to copy files to a computer connected to the product. You can also use it to
copy files on your computer to the storage device.

Precautions on Storage Devices

Keep the following in mind when copying files between your storage device and computer:

d  Check the documentation that came with your storage device and any adapter you may be using for any handling
guidelines.

4 Do not copy files to a storage device while you are printing from your storage device.

4 The product display does not update information about your storage device after you copy files to it or delete files
from it. To update the information displayed, eject and reload the storage device.

[d Do not eject your memory card or turn off the product while the memory card light is flashing or you may lose
data.

Copying Files Between a Storage Device and Your
Computer

Copying files to your computer

Make sure the product is turned on and a storage device is connected.

2 Windows 8.1 and 8:
Select All apps and then select Computer.

Windows 7 and Vista:
Click the start button and select Computer.

Windows XP:
Click Start and select My Computer.

Mac OS X: R
The removable disk icon (ﬂ 1) appears on your desktop automatically.
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Double-click the removable disk icon, then select the folder in which your files are saved.

Note:
Ifyou have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.

n Select the files you want to copy and drag them to a folder on your computer’s hard drive.

Important:

For Mac OS X users

When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on the device.

Saving files to a storage device

Note:

If USB is selected from the File Sharing Setup menu, you cannot write to the memory card from a computer connected
through a network. To give write access to the network computer, change the setting to Wi-Fi.

= “Setup Mode” on page 70

Make sure the product is turned on and a storage device is connected.

2 Windows 8.1 and 8:
Select All apps and then select Computer.

Windows 7 and Vista:
Click the start button and select Computer.

Windows XP:
Click Start and select My Computer.

Mac OS X: _
The removable disk icon (i I) appears on your desktop automatically.

Double-click the removable disk icon, then select the folder in which you want to save your files.

Note:
Ifyou have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.

n Select the folder on your computer’s hard drive that contains the files you want to copy. Then select the filesand
drag them to the folder on your storage device.

Important:

For Mac OS X users

When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on it.
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Error Indicators

Error Messages on the Control Panel

This section describes the meaning of messages displayed on the LCD screen.

The code will appear on the top right on the screen.

Code Situation Solutions

E-01 A printer error has occurred. Open the scanner unit and remove any paper or protective
material inside the printer. Turn the power off and on again.

E-02 A scanner error has occurred. Turn the power off and on again.

E-11 An ink pad needs to be replaced. Contact Epson or an authorised Epson service provider to replace
the ink pad”. It is not a user-serviceable part.

W-01 A paper jam has occurred. Remove the paperfromthe printerand press the button displayed
on the bottom of the LCD screen to clear the error. In some case,
you need to turn the power off and on again.
= “Paper Jams” on page 100

W-11 Anink padis nearing the end of its service | Press % to resume printing. The message will be displayed until

life. theink pad”is replaced. Contact Epson support to replace ink pads
before the end of their service life. When the ink pads are
saturated, the printer stops and Epson support is required to
continue printing.

|-22 Set Wi-Fi from the Push Button (WPS). Push the access point button. If there is no button on the access
point, open the access point setting window, and then click the
button displayed in the software.

I-23 Set Wi-Fi from the PIN Code (WPS). Enter the PIN code displayed on the LCD screen into the access
point or computer within two minutes.

I-31 Set Wi-Fi from the Wi-Fi Auto Connect. Install the software on your computer, and then press OK when
Wi-Fi setup starts.

I-41 Paper Configuration is disabled. Some If Paper Configurationisdisabled, you cannot use AirPrint. Touse

functions cannot be used. AirPrint, enable Paper Configuration.

I-60 Your computer may not support WSD The scan to computer (WSD) feature is only available for

(Web Services for Devices). computers running English versions of Windows 8.1, Windows 8,
Windows 7 or Windows Vista. Make sure that the printer is
correctly connected to the computer. See the Network Guide for
more details.
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Code Situation Solutions
Recovery The printer has started in recovery mode | Follow the steps below to try to update the firmware again.
Mode because the firmware update failed. 1.Connect the computer and the printer with a USB cable. (During

recovery mode, you cannot update the firmware over a network
connection.)
2. Visit your local Epson website for further instructions.

* In some print cycles a very small amount of surplus ink may be collected in the ink pad. To prevent ink leakage from the pad, the
printeris designed to stop printing when the pad has reached its limit. Whether and how often thisis required will vary according to
the number of pages you print, the type of material that you print and the number of cleaning cycles that the printer performs. The
need for replacement of the pad does not mean that your printer has ceased to operate in accordance with its specifications. The
printer will advise you when the pad requires replacing and this can only be performed by an authorised Epson Service provider.
The Epson warranty does not cover the cost of this replacement.
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Troubleshooting for Printing/Copying

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, then apply likely solutions
until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving,
the control panel, or the status monitor. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printing problem not related to print quality, or a paper
feeding problem, or if the product does not print at all, refer to the appropriate section.

To solve a problem, you may need to cancel printing.
= “Canceling Printing” on page 33
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Checking product status

If a problem occurs while printing, an error message will appear in the status monitor window.
If an error message appears indicating the product’s ink pads are nearing the end of their service life, contact Epson

support to replace them. The message will be displayed at regular intervals until the ink pads are replaced. When the
product’s ink pads are saturated, the product stops and Epson support is required to continue printing.

For Windows

There are two ways to access EPSON Status Monitor 3:

d  Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
= “From the shortcut icon on the taskbar” on page 29

4 Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button.

When you access EPSON Status Monitor 3, the following window appears:

B EPSON Status Monitor 3 : EPSON 10000000 ==

EPSON "%

Itis ready to print.

[ Tedhnical Support
Approximale Ink Levels
I I I
Cyan Maganta Yelow Black

The Approximate Ink Levels might be different from the actual ink levels. To confirm the actual
ink remaning, visually check the ink lzvels in ll the ink tanks of the printer. Continued use of
the product when the ink level is below the ne on the tank could damage the printer.

e =

Note:
IfEPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the Extended
Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

EPSON Status Monitor 3 provides the following information:

(4 Technical Support:
Click Technical Support to access the Epson technical support website.
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d Print Queue:
You can view Windows Spooler by clicking Print Queue.

For Mac OS X
Follow these steps to access EPSON Status Monitor.

1 Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 30

Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

‘800D Epson Printer Utility 4

EPSON Eepson xoooes

% EPSON Status Monitor

Approximate Ink Levels
The Approximate Ink Levels might be different from the actual ink levels. To
confirm the actual ink remaining, visually check the ink levels in all the ink tanks
of the printer. Continued use of the product when the ink level is below the line
on the tank could damage the printer.

iy

Cyan Magenta Yellow Black

| Update |F9&—]

Paper Jams

Caution:
Never touch the buttons on the control panel while your hand is inside the product.

Important:
Be careful not to pull the cables or ink tubes, or touch other components inside the product unnecessarily. Otherwise,
ink may leak or the product may be damaged.

Note:
Some products may come with a scanner unit support.
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Removing jammed paper from inside the product

Cancel the print job if prompted by a message from the printer driver.

= “Canceling Printing” on page 33

Open the scanner unit.

101



User’s Guide

Troubleshooting for Printing/Copying

n Close the scanner unit. If the jammed paper remains near the output tray, carefully remove the paper.

Press the button indicated in the LCD screen.

Preventing paper jams

If your paper jams frequently, check the following.

4 The paper is smooth, not curled or wrinkled.

d  You are using high-quality paper.

[ The printable side of the paper is face up in the sheet feeder.

[ The paper stack was fanned before loading.

4 For plain paper, do not load paper above the line just under the ¥ arrow mark inside the edge guide.

For Epson special media, make sure the number of sheets is less than the limit specified for the media.
= “Selecting Paper” on page 17

U

The edge guides are snug against the edges of the paper.

[ The productis on a flat, stable surface that extends beyond the base in all directions. The product will not operate
properly if it is tilted.

Reprinting after a paper jam (for Windows only)

After you cancel the print job because of a paper jam, you can reprint it without reprinting pages that have already been
printed.

Solve the paper jam.

= “Paper Jams” on page 100

Access the printer settings.

= “Accessing the printer driver for Windows” on page 29
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Select the Print Preview check box in the Main window of your printer driver.

Make the settings that you want to use to print.

Click OK to close the printer settings window, and then print your file. Print Preview window opens.

Select a page that has already been printed in the page list box on the left side, and then select Remove Page from
the Print Options menu. Repeat this step for all the pages that have already been printed.

Click Print on the Print Preview window.

~EoRo SN o

Print Quality Help

If you are having print quality problems, then compare it with the illustrations below. Click the caption under the
illustration that best resembles your prints.

cninalten alie

| Aufdruck. W
I 5008 "Regel

Good sample Good sample
clinaiien aiic TInanen ane
c Autdruck. Wy Aufdiuck. W
I 5008 "Regel | 15008 "Regel

= “Horizontal banding” on page 104 = “Vertical banding or misalignment” on
page 104

= “Horizontal banding” on page 104 = “Vertical banding or misalignment” on
page 104
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= “Incorrect or missing colors” on page 105 = “Blurry or smeared print” on page 105

Horizontal banding

4

4

Make sure the printable side (the whiter or glossier side) of the paper is face up in the sheet feeder.

Run the Head Cleaning utility to clear any clogged ink nozzles.
= “Cleaning the Print Head” on page 79

If you have not used the product for a long time, use the Power Ink Flushing utility of the printer driver.
= “Replacing Ink inside the Ink Tubes” on page 82

Try to use genuine Epson ink bottles.

Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.

= “Selecting Paper” on page 17

If banding appears at intervals of 2.5 cm, run the Print Head Alignment utility.
= “Aligning the Print Head” on page 81

If there is problem with copy quality, clean the surface of the scanner glass.
= “Cleaning the exterior of the product” on page 87

Vertical banding or misalignment

4

N

Make sure the printable side (the whiter or glossier side) of the paper is face up in the sheet feeder.

Run the Head Cleaning utility to clear any clogged ink nozzles.
= “Cleaning the Print Head” on page 79

If you have not used the product for a long time, use the Power Ink Flushing utility of the printer driver.
= “Replacing Ink inside the Ink Tubes” on page 82

Run the Print Head Alignment utility.
= “Aligning the Print Head” on page 81

For Windows, clear the High Speed check box from the More Options window in your printer driver. See the

online help for details.

For Mac OS X, select Off from the High Speed Printing. To display the High Speed Printing, click through the
following menus: System Preferences, Printers & Scanners (for Mac OS X 10.9), Print & Scan (for Mac OS X 10.8
or 10.7) or Print & Fax (for Mac OS X 10.6), your product (in the Printers list box), Options & Supplies, and then
Driver.
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Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.

= “Selecting Paper” on page 17

If there is problem with copy quality, clean the surface of the scanner glass.
= “Cleaning the exterior of the product” on page 87

Incorrect or missing colors

4

N

N

Make sure the initial ink charging is complete.
Check the ink tank. If the tank is empty, refill the ink immediately and run the Head Cleaning utility.

For Windows, clear the Grayscale setting in the Main window in your printer driver.
For Mac OS X, clear the Grayscale setting in Print Settings in the Print dialog box in your printer driver.

Adjust the color settings in your application or in your printer driver settings.
For Windows, check the Color Management settings in the Advanced window.

For Mac OS X, check the Color Options dialog box from the Print dialog box.

Run the Head Cleaning utility to clear any clogged ink nozzles.
= “Cleaning the Print Head” on page 79

If you have not used the product for a long time, use the Power Ink Flushing utility of the printer driver.
= “Replacing Ink inside the Ink Tubes” on page 82

Try to use genuine Epson ink bottles and paper recommended by Epson.

Blurry or smeared print

4

U U o U U

U

Try to use genuine Epson ink bottles and paper recommended by Epson.

Make sure the productis on a flat, stable surface that extends beyond the base in all directions. The product will not
operate properly if it is tilted.

Make sure your paper is not damaged, dirty, or too old.
Make sure your paper is dry and the printable side (the whiter or glossier side) is face up in the sheet feeder.
If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.

= “Selecting Paper” on page 17
Remove each sheet from the output tray as it is printed.

Do not touch or allow anything to come into contact with the printed side of paper with a shiny finish. To handle
your prints, follow the instructions of the paper.

Run the Head Cleaning utility to clear any clogged ink nozzles.
= “Cleaning the Print Head” on page 79
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4 Ifyou have not used the product for a long time, use the Power Ink Flushing utility of the printer driver.
= “Replacing Ink inside the Ink Tubes” on page 82

(4 Run the Print Head Alignment utility.
= “Aligning the Print Head” on page 81

4 If the paper is smeared with ink after printing, clean the interior of the product.
= “Cleaning the interior of the product” on page 87

4 If there is problem with copy quality, clean the surface of the scanner glass.
= “Cleaning the exterior of the product” on page 87

Miscellaneous Printout Problems

Incorrect or garbled characters

4 Clear any stalled print jobs.
= “Canceling Printing” on page 33

4 Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

(A Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 91

Incorrect margins

[ Make sure that the paper is loaded into the sheet feeder correctly.
= “Loading Paper and Envelopes” on page 19

[ Check the margin settings in your application. Make sure that the margins are within the printable area of the
page.
= “Printable area” on page 119

[ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.

[ Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 91

Printout has a slight slant

[ Make sure that the paper is loaded into the sheet feeder correctly.
= “Loading Paper and Envelopes” on page 19

[d If Draft is selected in Quality in the Main window in your printer driver (for Windows), or Fast Economy is
selected in Print Quality in Print Settings (for Mac OS X), select another setting.
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Size or position of copied image is incorrect

[d  If the edges of the copy are cropped off, move the original slightly away from the corner.

4 Clean the scanner glass.
= “Cleaning the exterior of the product” on page 87

Inverted image

d For Windows, clear the Mirror Image check box from the More Options window of your printer driver, or turn
off the Mirror Image setting in your application.
For Mac OS X, clear the Mirror Image check box in Print Settings in the Print dialog box of your printer driver, or
turn off the Mirror Image setting in your application.

[  Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 91

Blank pages print

[ Check the ink tank. If the tank is empty, refill the ink immediately and run the Head Cleaning utility.
= “Cleaning the Print Head” on page 79

[ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.

[ For Windows, check the Skip Blank Page setting by clicking the Extended Settings button on the Maintenance
window of the printer driver.
For Mac OS X, select On from the Skip Blank Page. To display the Skip Blank Page, click through the following
menus: System Preferences, Printers & Scanners (for Mac OS X 10.9) or Print & Scan (for Mac OS X 10.8 or 10.7)
or Print & Fax (for Mac OS X 10.6), your product (in the Printers list box), Options & Supplies, and then
Driver.

[ Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 91

Printed side is smeared or scuffed

[d If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

[ Load a A4-size plain paper until the paper is not smeared with ink.
= “Cleaning the interior of the product” on page 87

(A Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 91
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Printing is too slow

4

Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
= “Selecting Paper” on page 17

For Windows, choose a lower Quality in the printer driver Main window.
For Mac OS X, choose alower Print Quality in the Print Settings dialog box from your printer driver’s Print dialog
box.

= “Accessing the printer driver for Windows” on page 29
= “Accessing the printer driver for Mac OS X” on page 30

Close any unnecessary applications.

If you print continuously for an extended period, the printing may be extremely slow. This is to slow down the
printing speed and prevent the product mechanism from overheating and being damaged. If this happens, you
can continue to print, but we recommend stopping and leaving the product idle for at least 30 minutes with the
power on. (The product does not recover with the power off.) After you restart, the product will print at normal
speed.

Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 91

Paper Does Not Feed Correctly

Paper does not feed

Remove the stack of paper and make sure of the following:

N

4

4

The paper is not curled or creased.

The paper is not too old. See the instructions that came with the paper for more information.

For plain paper, do not load paper above the line just under the ¥ arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.

= “Selecting Paper” on page 17

Paper is not jammed inside the product. If it is, remove the jammed paper.
= “Paper Jams” on page 100

You have followed any special loading instructions that came with your paper.

Multiple pages feed

4

For plain paper, do not load paper above the line just under the ¥ arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
= “Selecting Paper” on page 17

Make sure the edge guides are snug against the edges of the paper.
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(4 Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite side before
loading.

[ Remove the stack of paper and make sure that the paper is not too thin.
= “Paper” on page 118

[ Fan the edges of the stack to separate the sheets, then reload the paper.

d Iftoo many copies of a file are being printed, check the Copies setting in your printer driver as follows, and also
check in your application.
For Windows, check the Copies setting on the Main window.
Mac OS X, check the Copies setting in the Print dialog.

Paper is improperly loaded

Ifyou have loaded the paper too far into the product, the product cannot feed the paper correctly. Turn the product off
and gently remove the paper. Then turn the product on and reload the paper correctly.

Paper is not ejected fully or is wrinkled

4 Ifthe paper does not eject fully, press the & button to eject the paper. If the paper is jammed inside the product,
remove it by referring to the following section.
= “Paper Jams” on page 100

4 If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The Product Does Not Print

All lights are off

[  Press the O button to make sure the product is on.
4  Make sure that the power cord is securely plugged in.

[  Make sure that your outlet works and is not controlled by a wall switch or timer.

Only the power light is on

4 Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

d Ifyou are using the USB interface, make sure your cable meets the USB or Hi-Speed USB standards.
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4 Ifyouare connecting the product to your computer via a USB hub, connect the product to the first-tier hub from
your computer. If the printer driver is still not recognized on your computer, try to directly connect the product to
your computer without the USB hub.

4 Ifyouare connecting the product to your computer via a USB hub, make sure the USB hub device is recognized by
your computer.

d Ifyouaretryingto printalarge image, your computer may not have enough memory. Try reducing the resolution
of your image or printing the image at a smaller size. You may need to install more memory in your computer.

4 Users of Windows can clear any stalled print jobs from the Windows Spooler.
= “Canceling Printing” on page 33

(A Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 91

A message prompting you to reset the ink levels is displayed

Refill all or the specified ink tanks, select the color that you refilled on the LCD screen, and then press & to reset the ink
levels.

Depending on the usage conditions, the message may be displayed when there is still ink in the tank.
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Problems Indicated by Messages on the LCD Screen or
Status Light

N

N

Make sure the product is connected to your computer properly.

Turn off the product and turn it on again. If the problem is not solved, the product may be malfunctioning, or the
light source in the scanner unit may need to be replaced. Contact your dealer.

Make sure the scanning software is fully installed.
= “Where To Get Help” on page 125

Problems When Starting a Scan

N

4

Check the status light and make sure the product is ready to scan.

Make sure your cables are securely connected to the product and a working electrical outlet.
If necessary, test your product’s AC adapter by plugging in another electrical device and turning it on.

Turn off the product and computer, and then check the interface cable connection between them to make sureitis
secure.

Make sure you select the correct product if a scanner list appears when starting to scan.

Windows:
When you start Epson Scan using the EPSON Scan icon, and the Select Scanner list is displayed, make sure you
select the model of your product.

Mac OS X:
When you start Epson Scan from the Applications folder and the Select Scanner list is displayed, make sure you
select the model of your product.

Connect the product directly to the computer’s external USB port or through one USB hub only. The product may
not work properly when connected to the computer through more than one USB hub. If the problem persists, try
connecting the product directly to the computer.

If more than one product is connected to your computer, it may not work. Connect only the product you want to
use, and then try scanning again.

Ifthe scanning software does not work properly, uninstall the software first and then reinstall it as described in the
paper manual.
= “Uninstalling Your Software” on page 91
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Using the button

4 Check if you have assigned a program to the button.
= “Epson Event Manager” on page 66

(4 Make sure Epson Scan and Epson Event Manager are installed correctly.

d Ifyouhaveclicked the Keep Blocking button in the Windows Security Alert window during or after installation of
the Epson Software, unblock Epson Event Manager.

= “How to unblock Epson Event Manager” on page 112
How to unblock Epson Event Manager

Click Start or the start button, and then point to Control Panel.

For Windows 8.1 and 8:
Select Control Panel from Settings.

Do one of the following.

(d Windows 8.1, 8 and 7:
Select System and Security.

[ Windows Vista:
Select Security.

1 Windows XP:
Select Security Center.

Do one of the following.

d Windows 8.1, 8, 7 and Windows Vista:
Select Allow a program/an app through Windows Firewall.

d Windows XP:
Select Windows Firewall.

n Do one of the following.

(d Windows 8.1, 8 and 7:
Confirm that the check box for EEventManager Application is selected in the Allowed programs/apps
and features list.

d Windows Vista:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Program or port list.

d Windows XP:

Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Programs and Services list.

Click OK.
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Using scanning software other than Epson Scan driver

d Ifyouareusingany TWAIN-compliant programs, such as Adobe Photoshop Elements, make sure that the correct
product is selected as the Scanner or Source setting.

d  If you cannot scan using any TWAIN-compliant scanning programs, such as Adobe Photoshop Elements,

uninstall the TWAIN-compliant scanning program and then reinstall it.
= “Uninstalling Your Software” on page 91

Problems When Feeding Paper

The paper gets dirty

You may need to clean the product.
= “Cleaning the Product” on page 87

Multiple sheets of paper are fed

4 Ifyou load unsupported paper, the product may feed more than one sheet of paper at a time.

d  You may need to clean the product.
= “Cleaning the Product” on page 87

Problems With Scanning Time

4 Computers with Hi-Speed external USB ports can scan faster than those with external USB ports. If youare using a
Hi-Speed external USB port with your product, make sure it meets the system requirements.
= “System Requirements” on page 117

d  Scanning at a high resolution takes a long time.

Problems With Scanned Images

Scan quality is unsatisfactory

Scan quality can be improved by changing the current settings or adjusting the scanned image.
= “Image Adjustment Features” on page 47
An image on the back of your original appears in your scanned image

If your original is printed on thin paper, images on the back may be visible to the product and appear in your scanned
image. Try scanning the original with a piece of black paper placed on the back of it. Also make sure the Document
Type and Image Type settings are correct for your original.
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Characters are distorted or blurred

d In Office Mode or Home Mode, select the Text Enhancement check box.
d  Adjust the Threshold setting.
Home Mode:
Select Black&White as the Image Type setting, click the Brightness button, and then try adjusting the Threshold

setting.

Office Mode:
Select Black&White as the Image Type setting, and then try adjusting the Threshold setting.

Professional Mode:

Select Black & White as the Image Type setting and click the + (Windows) or» (Mac OS X) button next to Image
Type. Make the appropriate Image Option setting and then try adjusting the Threshold setting.

[d Increase the resolution setting.

Characters are not recognized correctly when converted into editable text
(OCR)

Place the document so that it is straight on the scanner glass. If the document is skewed, it may not be recognized
correctly.

Ripple patterns appear in your scanned image
A ripple or cross-hatch pattern (known as moiré) may appear in a scanned image of a printed document.

=5

[d Rotate your original document. Rotate the scanned image using the application software after scanning.
[ Select the Descreening check box.

[ Change a resolution setting and scan again.

Uneven color, smears, dots, or straight lines appear in your image

You may need to clean the interior of the product.

= “Cleaning the Product” on page 87
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The scanning area or direction is unsatisfactory

The edges of your original are not scanned

d Ifyouare scanning in Full Auto Mode, or using thumbnail preview in Home Mode or Professional Mode, move
the document or photo 6 mm (0.2 inch) away from the horizontal and vertical edges of the scanner glass to avoid

cropping.

4 Ifyouarescanning using the button or using normal preview in Office Mode, Home Mode, or Professional Mode,
move the document or photo about 3 mm (0.12 inch) away from the horizontal and vertical edges of the scanner
glass to avoid cropping.

Multiple documents are scanned into a single file

Position documents at least 20 mm (0.8 inch) apart from each other on the scanner glass.

Cannot scan the area you want

Depending on the documents, you may not be able to scan the area you want. Use normal preview in Office Mode,
Home Mode, or Professional Mode and create marquees on the area you want to scan.

Cannot scan in the direction you want

Click Configuration, select the Preview tab, and then clear the Auto Photo Orientation check box. Then, place your
documents correctly.
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Problems Remain After Trying All Solutions

If you have tried all the solutions and have not solved the problem, initialize the Epson Scan settings.

Click Configuration, select the Other tab, and then click Reset All.
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Ink Bottles

You can use the following ink bottles with this product:

Ink Bottles Part numbers
Black T6641
Cyan T6642
Magenta T6643
Yellow T6644

g Important:

Use of genuine Epson ink other than specified could cause damage that is not covered by Epson’s warranties.

Color Black, Cyan, Magenta, Yellow

Temperature Storage:
-20t040 "C(-4t0 104 °F)

1 month at 40 °C (104 °F)

Freezing:*
-15°C(5°F)

* Ink thaws and is usable after approximately 2 hours at 25 "C (77 °F).

System Requirements

For Windows

System PC Interface

Windows 8.1 (32-bit, 64-bit), Windows 8 (32-bit, 64-bit), Windows 7 (32-bit, 64-bit), | Hi-Speed USB
Vista (32-bit, 64-bit), XP SP1 or higher(32-bit), or XP Professional x64 Edition

For Mac OS X
System PC Interface
Mac OS X v10.9.x, Mac OS X v10.8.x, Mac OS X v10.7.x, Mac OS X v10.6.8 Hi-Speed USB
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Note:
The UNIX File System (UFS) for Mac OS X is not supported.

Technical Specifications

Note:
Specifications are subject to change without notice.

Printer specifications

Paper path Sheet feeder, top entry

Capacity 11 mm (0.4in) 12

*1 For Legal and User Defined sizes, load one sheet at a time.

*2 Paper with a weight of 64 to 90 g/m*(17 to 24 Ib).

Paper

Note:

[ Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time,
Epson cannot attest to the quality of any non-Epson brand or type of paper. Always test samples of paper stock
before purchasing large quantities or printing large jobs.

[  Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter
problems, switch to a higher grade of paper.

Single sheets:

Size A4210 x 297 mm
10x15cm (4 x6in.)
13x18cm (5x7in.)
A6 105 x 148 mm

A5 148 x 210 mm

B5 182 x 257 mm
9x13cm (3.5x5in.)
13x20cm (5% 8in.)
20x25cm (8 x 10in.)
16:9 wide size (102 x 181 mm)
100 x 148 mm
Letter81/2x 11 in.
Legal 8 1/2 x 14 in.

Paper types Plain paper or special paper distributed by Epson
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Thickness
(for plain paper)

0.08 t0 0.11 mm (0.003 to 0.004 in.)

Weight 64 g/m” (17 Ib) to 90 g/m? (24 Ib)
(for plain paper)
Envelopes:
Size Envelope #104 1/8 x 9 1/2in.
Envelope DL 110 x 220 mm
Envelope C6 114 x 162 mm
Paper types Plain paper
Weight 75 g/m? (20 Ib) to 90 g/m? (24 Ib)
Printable area

Highlighted portions show printable area.

Single sheets:
' .
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1
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119




User’s Guide

Product Information

Media type Single sheets Envelopes

A 3.0mm (0.121in.) 3.0mm (0.12/in.)
B 3.0mm (0.12in.) 5.0 mm (0.20in.)
C 3.0mm (0.12in.) 20.0 mm (0.78 in.)

Note:

Depending on the type of paper, print quality may decline in the top and bottom areas of the print, or the area may be

smeared.

Scanner specifications

Scanner type

Flatbed color

Photoelectric device

cls

Document size

216 x 297 mm (8.5 x 11.7 inches) A4 or US letter size

Scanning resolution

1200 dpi (main scan)
2400 dpi (sub scan)

Color Depth

Color

[ 48 bits per pixel internal (16 bits per pixel per color internal)
[ 24 bits per pixel external (8 bits per pixel per color external)
Grayscale

[ 16 bits per pixel internal

1 8 bits per pixel external

Black and white

[ 16 bits per pixel internal

1 bits per pixel external

Light source

LED
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Network interface specification

Wi-Fi

Standard:

IEEE 802.11b/g/n™

Security:

WEP (64/128bit)
WPA-PSK (TKIP/AES) "2

Frequency Band:

2.4 GHz

Communication Mode:

Infrastructure, Ad hoc™3, Wi-Fi Direct™#">

*1 Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.
*2 Complies with WPA2 with support for WPA/WPA2 Personal.

*3 Not supported for IEEE 802.11
*4 Not supported for IEEE 802.11

n.

b.

*5 Simple AP mode is compatible with Wi-Fi connection (infrastructure).

Security Protocol

SSL/TLS

HTTPS Server/Client, IPPS

Supported Third Party Services
AirPrint Print iOS 5 or later/Mac OS X v10.7.x or later
Scan Mac OS X v10.9.x or later
Google Cloud Print
Memory card
Compatible memory SDXC
cards SDHC
SD
miniSDHC"
miniSD”
microSDXC”
microSDHC”
microSD*

Media format DCF

DCF (Design rule for Camera File system) version 1.0 or 2.0 compliant.

All card types standard version compliant.

Voltage Requirements

33v

* Adapter required.

121




User’s Guide

Product Information

Photo data specifications

File format JPEG with the Exif Version 2.3 standard
Image size 80 x 80 pixels to 10200 x 10200 pixels
Number of files Up to 2000"

* Up to 999 files can be displayed at a time. (If the number of files exceeds 999, the files are displayed in groups.)

Mechanical

Dimensions Storage

Width: 482 mm (19.0 inch)
Depth: 300 mm (11.8 inches)
Height: 145 mm (5.7 inches)

Printing™’

Width: 482 mm (19.0 inch)
Depth: 528 mm (20.8 inches)
Height: 279 mm (11.0 inches)

Weight Approx. 4.5 kg (9.9 Ib)2

*1 With the output tray extension extended.

*2 Without the power cord.
Electrical
100-240 V Model 220-240 V Model
Input voltage range 90 to 264V 198 to 264V
Rated frequency range 50to 60 Hz 50 to 60 Hz
Input frequency range 49.5 10 60.5 Hz 49.5 10 60.5 Hz
Rated current 0.5t003A 03A
Power consumption Standalone copying Approx. 13 W (ISO/IEC24712) | Approx.13 W (ISO/IEC24712)
Ready mode Approx. 5.0 W Approx. 5.0 W
Sleep mode Approx. 1.5 W Approx. 1.5 W
Power off Approx. 0.3 W Approx. 0.3 W
Note:

Check the label on the back of the product for its voltage.
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Environmental

Temperature

Operation:
10to 35 °C (50 to 95 °F)

Storage:
-20t040 "C(-4to0 104 °F)

1 month at 40 °C (104 °F)

Humidity

Operation:*
20 to 80% RH

Storage:*
5 to 85% RH

* Without condensation

Standards and approvals

U.S. model:
Safety UL60950-1
CAN/CSA-C22.2 No0.60950-1
EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

These equipments contains the following wireless module.
Manufacture: Askey Computer Corporation

Type: WLU6320-D69(RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for
any failure to satisfy the protection requirements resulting from a non-recommended modification of the product.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to

licensing.

European model:

Low voltage directive 2006/95/
EC

EN60950-1

EMC directive 2004/108/EC

EN55022 Class B
EN61000-3-2
EN61000-3-3
EN55024

R&TTE directive 1999/5/EC

EN300 328
EN301 489-1
EN301 489-17
EN60950-1
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For European users:
We, Seiko Epson Corporation, hereby declare that the equipment Model, C462R is in compliance with the essential
requirements and other relevant provisions of Directive 1999/5/EC.

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Croatia, Cyprus, Greece, Slovenia,
Malta, Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Epson can not accept responsibility for any failure to satisfy the protection requirements resulting a
non-recommended modification of the products.

Interface

Hi-Speed USB (Device Class for computers)
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Where To Get Help

Technical Support Web Site

Epson’s Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting
information in your product documentation. If you havea Web browser and can connect to the Internet, access the site
at:

http://support.epson.net/

If you need the latest drivers, FAQs, manuals, or other downloadables, access the site at:

http://www.epson.com

Then, select the support section of your local Epson Web site.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product documentation, contact Epson support services for assistance. If Epson support for your
area is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

d  Product serial number
(The serial number label is usually on the back of the product.)

d  Product model

4 Product software version
(Click About, Version Info, or similar button in the product software.)

4 Brand and model of your computer
d  Your computer operating system name and version

[ Names and versions of the software applications you normally use with your product

Note:

Depending on the product, the dial list data for fax and/or network settings may be stored in the product’s memory. Due to
breakdown or repair of a product, data and/or settings may be lost. Epson shall not be responsible for the loss of any data, for
backing up or recovering data and/or settings even during a warranty period. We recommend that you make your own
backup data or take notes.
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Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Taiwan

Contacts for information, support, and services are:

World Wide Web (http://www.epson.com.tw)

Information on product specifications, drivers for download, and products enquiry are available.

Epson HelpDesk (Phone: +0280242008)

Our HelpDesk team can help you with the following over the phone:
4 Sales enquiries and product information
d  Product usage questions or problems

4 Enquiries on repair service and warranty

Repair service center:

Telephone number

Fax number

Address

02-23416969

02-23417070

No.20, Beiping E. Rd., Zhongzheng Dist., Taipei City 100,
Taiwan

02-27491234

02-27495955

1F., No.16, Sec. 5, Nanjing E. Rd., Songshan Dist., Taipei City
105, Taiwan

02-32340688

02-32340699

No.1, Ln. 359, Sec. 2, Zhongshan Rd., Zhonghe City, Taipei
County 235, Taiwan

039-605007 039-600969 No.342-1, Guangrong Rd., Luodong Township, Yilan County
265, Taiwan

038-312966 038-312977 No.87, Guolian 2nd Rd., Hualien City, Hualien County 970,
Taiwan

03-4393119 03-4396589 5F., No.2, Nandong Rd., Pingzhen City, Taoyuan County
32455, Taiwan (R.O0.C))

03-5325077 03-5320092 1F.,No.9,Ln.379, Sec. 1, Jingguo Rd., North Dist., Hsinchu City

300, Taiwan

04-23011502

04-23011503

3F., No.30, Dahe Rd., West Dist., Taichung City 40341, Taiwan
(R.O.C)

04-23805000

04-23806000

No.530, Sec. 4, Henan Rd., Nantun Dist., Taichung City 408,
Taiwan

05-2784222

05-2784555

No.463, Zhongxiao Rd., East Dist., Chiayi City 600, Taiwan

06-2221666

06-2112555

No.141, Gongyuan N. Rd., North Dist., Tainan City 704, Taiwan
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Telephone number Fax number Address

07-5520918 07-5540926 1F., No.337, Minghua Rd., Gushan Dist., Kaohsiung City 804,
Taiwan

07-3222445 07-3218085 No.51, Shandong St., Sanmin Dist., Kaohsiung City 807,
Taiwan

08-7344771 08-7344802 1F.,No.113, Shengli Rd., Pingtung City, Pingtung County 900,
Taiwan

Help for Users in Singapore

Sources of information, support, and services available from Epson Singapore are:

World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), Sales Enquiries,
and Technical Support via e-mail are available.

Epson HelpDesk (Phone: (65) 6586 3111)

Our HelpDesk team can help you with the following over the phone:
(4 Sales enquiries and product information
4 Product usage questions or problems

1 Enquiries on repair service and warranty

Help for Users in Thailand

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and e-mail are
available.

Epson Hotline (Phone: (66)2685-9899)

Our Hotline team can help you with the following over the phone:
(4 Sales enquiries and product information
4 Product usage questions or problems

(d  Enquiries on repair service and warranty
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Help for Users in Vietnam
Contacts for information, support, and services are:
Epson Hotline (Phone): 84-8-823-9239

Service Center: 80 Truong Dinh Street, District 1, Hochiminh City
Vietnam

Help for Users in Indonesia

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.id)

1 Information on product specifications, drivers for download

d  Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Hotline
(4 Sales enquiries and product information
(A Technical support

Phone (62) 21-572 4350

Fax (62) 21-572 4357

Epson Service Center

Jakarta Mangga Dua Mall 3rd floor No 3A/B
JI. Arteri Mangga Dua,
Jakarta

Phone/Fax: (62) 21-62301104

Bandung Lippo Center 8th floor
J1. Gatot Subroto No.2
Bandung

Phone/Fax: (62) 22-7303766
Surabaya Hitech Mall It IIB No. 12

JI. Kusuma Bangsa 116 - 118

Surabaya

Phone: (62) 31-5355035
Fax: (62)31-5477837
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Yogyakarta Hotel Natour Garuda
J1. Malioboro No. 60
Yogyakarta

Phone: (62) 274-565478
Medan Wisma HSBC 4th floor

JI. Diponegoro No. 11

Medan

Phone/Fax: (62) 61-4516173
Makassar MTC Karebosi Lt. Il Kav. P7-8

JI. Ahmad Yani No.49

Makassar

Phone: (62)411-350147/411-350148

Help for Users in Hong Kong

To obtain technical support as well as other after-sales services, users are welcome to contact Epson Hong Kong
Limited.

Internet Home Page

Epson Hong Kong has established alocal home page in both Chinese and English on the Internet to provide users with
the following information:

4 Product information

[ Answers to Frequently Asked Questions (FAQs)
(1 Latest versions of Epson product drivers

Users can access our World Wide Web home page at:

http://www.epson.com.hk

Technical Support Hotline

You can also contact our technical staff at the following telephone and fax numbers:
Phone: (852) 2827-8911

Fax: (852) 2827-4383

Help for Users in Malaysia

Contacts for information, support, and services are:
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World Wide Web (http://www.epson.com.my)

1 Information on product specifications, drivers for download

d  Frequently Asked Questions (FAQ), Sales Enquiries, questions through e-mail

Epson Trading (M) Sdn. Bhd.

Head Office.

Phone: 603-56288288
Fax: 603-56288388/399
Epson Helpdesk

4 Sales enquiries and product information (Infoline)

Phone: 603-56288222

4 Enquiries on repair services & warranty, product usage and technical support (Techline)

Phone: 603-56288333

Help for Users in India

Contacts for information, support, and services are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers for download, and products enquiry are available.

Epson India Head Office - Bangalore

Phone: 080-30515000

Fax: 30515005

Epson India Regional Offices:

Location Telephone number Fax number

Mumbai 022-28261515 /16/17 022-28257287
Delhi 011-30615000 011-30615005
Chennai 044-30277500 044-30277575
Kolkata 033-22831589/90 033-22831591
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Location Telephone number Fax number
Hyderabad 040-66331738/ 39 040-66328633
Cochin 0484-2357950 0484-2357950
Coimbatore 0422-2380002 NA
Pune 020-30286000 /30286001/30286002 020-30286000
Ahmedabad 079-26407176 /77 079-26407347

Helpline

For Service, Product info or to order a cartridge - 18004250011 (9AM - 9PM) - This is a Toll-free number.

For Service (CDMA & Mobile Users) - 3900 1600 (9AM - 6PM) Prefix local STD code

Help for Users in the Philippines

To obtain technical support as well as other after sales services, users are welcome to contact the Epson Philippines
Corporation at the telephone and fax numbers and e-mail address below:

Trunk Line: (63-2) 706 2609
Fax: (63-2) 706 2665

Helpdesk Direct Line:  (63-2) 706 2625

E-mail: epchelpdesk@epc.epson.com.ph

World Wide Web (http://www.epson.com.ph)

Information on product specifications, drivers for download, Frequently Asked Questions (FAQ), and E-mail
Enquiries are available.

Toll-Free No. 1800-1069-EPSON(37766)

Our Hotline team can help you with the following over the phone:
4 Sales enquiries and product information

4 Product usage questions or problems

(4 Enquiries on repair service and warranty
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